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Installation

Starting Setup
To install Picture It!, you must be running Windows 98, Windows Me, 
Windows 2000, or Windows XP or later. On Windows 2000 and Windows XP 
systems, you must have administrative privileges. For information regarding 
privileges, please refer to the operating system Help. 

On most computers, Picture It! setup will begin automatically when you insert 
the Picture It! CD into your disk drive.

To begin automatic setup:

 1 Turn off any antivirus software that you’re using, and close any programs 
that are running. 

 2 Insert the Picture It! CD into your disk drive. The Installation Wizard 
begins automatically. 

If the above procedure does not start the setup process, you can start it 
manually.

To begin setup manually:

 1 Turn off any antivirus software that you’re using, and close any programs 
that are running.

 2 Insert the Picture It! CD into your disk drive.
 3 Click Start, and then click Run.
 4 If your CD-ROM drive is listed as letter D, type d:\setup.exe.

If your CD-ROM drive has a letter other than D, replace D with the cor-
rect letter when you type the path.

 5 Click OK.
The Installation Wizard begins.
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Completing the Installation Wizard
The Installation Wizard will show you a series of dialog boxes that provide 
setup status and some installation preference options. For most users, the 
default preferences will be appropriate. Information about the different setup 
options is provided below.

Installation Folder Dialog Box
The Installation Folder dialog box allows you to choose where the program will 
be installed on your computer. To install the program to a folder other than the 
folder in the Installation folder box, do one of the following:

 Type a different path in the Installation folder box.
 Click Change, select a folder in the Change Installation Folder dialog 

box, and then click OK.

Note that some files will be installed to the Program Files drive even if you 
choose to install the program to a different drive. 

Installation Options Dialog Box
The Installation Options dialog box allows you to choose between Typical 
installation and Full installation. 

 Typical installation takes up less space on your hard drive, and is recom-
mended for most users. With Typical installation, you will have to insert 
the Picture It! CD in your CD-ROM drive to use some of the projects and 
clip art while you are using the program.

 Full installation copies all of the Picture It! projects and clip art to your 
hard drive, so you will not have to reinsert a Picture It! CD while you are 
using the program. Look under Description for the disk space required 
for this option.
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Special Circumstances

Upgrading from a Different Picture It! Product
If you already have a Picture It! product installed on your machine, any of 
several scenarios may occur when you try to install another Picture It! product: 

 Previous versions If you have a Picture It! product previous to version 9 
already installed, installing a version 9 product will make both programs 
available on your computer.

 Upgrade from another version 9 product You can install a Picture It! 
version 9 product that has more features than a version 9 product already 
installed. The version of Picture It! with fewer features will be unin-
stalled automatically before the new installation begins. Your pictures and 
projects will not be deleted.

 Blocked downgrade If you have a Picture It! version 9 product installed, 
you will not be able to automatically install a version 9 product with 
fewer features. To install the version with fewer features, you must first 
uninstall the version with more features.

Reinstalling or Removing Picture It! 
If you are having problems running Picture It!, reinstalling the program may 
help it to run better on your computer.

You should not attempt to remove Picture It! by deleting the program files 
from your hard disk. Instead, use the Picture It! Installation Wizard to properly 
uninstall the program.

To remove or reinstall Picture It! from Windows XP:

 1 Log on to the computer as an administrator.
 2 From the Windows Start menu, click Control Panel.
 3 Click Add or Remove Programs.
 4 From the list of installed programs, click the version of Picture It! you 

want to remove or reinstall. 
 5 Click Change/Remove.

The Installation Wizard opens.
 6 Follow the instructions on the screen.

Other Picture It! 
Products
The family of Picture 
It! products includes 
programs with the 
following brands:

 Digital Image 

 Greetings

 Greetings Workshop

 Home Publishing

 Picture It!

 Picture It! Express

 Picture It! Photo

 Picture It! Publishing
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To remove or reinstall Picture It! from Windows 98, Windows 2000, 
or Windows Me:

 1 From the Windows Start menu, point to Settings, and then click Control 
Panel.

 2 Click Add/Remove Programs.
 3 From the list of installed programs, click the version of Picture It! you 

want to remove or reinstall.
 4 Click Add/Remove.

The Installation Wizard opens.
 5 Follow the instructions on the screen.
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Welcome to Microsoft Picture It! 
Photo Premium

Congratulations on your purchase of Microsoft Picture It! Photo Premium, 
a unique combination of robust photo-editing tools and high-quality photo 
projects. While easy to use, Picture It! offers powerful imaging technology that 
helps you improve your photos.

What’s New?
Since the release of Picture It! 1.0 in 1996, Microsoft has repeatedly updated 
Picture It! with new features, improved design, and innovative projects. Its 
current version Picture It! has been updated and improved once again, built on 
a strong imaging foundation from years of research and feedback from users. 
Improvements for Picture It! version 9 include: 

 New selection tools make it easier to be more precise when editing and 
applying effects. 

 New Unsharp Mask and Gaussian blur tools let you apply more realis-
tic-looking sharpening and blurring effects. 

 The new straighten picture feature can fix photos taken while the 
camera wasn’t straight. 

 New rule of thirds guidelines in the crop task help you improve the 
composition of your pictures. 
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Other Helpful Resources
This User’s Manual is not an exhaustive resource for everything you can do 
with Picture It!. For step-by-step instructions about using all of the program’s 
features, check out the online Help system, available from the Startup Window 
or the Help menu. Or, for a demonstration of some key Picture It! features, 
watch one of the Instructional Videos.

Digital photography is fun and exciting, and Picture It! makes it easy to get 
great results. 
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Opening and Importing Pictures

Picture It! makes it easy to import and open your pictures quickly. To transfer 
pictures from your camera or storage media to your computer, use the new 
Import Pictures Wizard. This wizard is designed to streamline the file transfer 
process, allowing you to name the picture files and destination folder. To open 
pictures for editing, use the file browser. The file browser displays thumbnails 
of all your pictures, so you can quickly choose the ones you want. 

Importing Pictures
The Import Pictures Wizard is a convenient way to transfer pictures and video 
clips from your digital camera or other storage location to your computer. The 
Import Pictures Wizard helps you rename the files so that they have recogniz-
able file names. 

Launching the Import Pictures Wizard automatically 
Windows Me and Windows XP can automatically detect compatible cameras 
and other photo media such as photo CDs. This detection should occur when 
you:

 Connect a compatible camera to the computer and turn on the camera.
 Connect a compatible card reader to the computer and insert media.
 Insert a photo CD, DVD, or other storage media into a drive on the 

computer.

This automatic detection feature is only available on Windows Me and Win-
dows XP and with WIA and USB Mass Storage class devices.
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To set Windows to launch the Import Pictures Wizard automatically:

 1 Connect your compatible camera or device to the computer, and then turn 
on the camera or device.
- or -
Insert the storage media into a drive on the computer.

 2 When Windows detects the picture files, Windows will ask you what you 
want to do with the pictures.

 3 Click Import pictures using Microsoft Picture It! Import Wizard. 
 4 Check Always do the selected action.
 5 Click OK.
 6 Click the device you want to use, and then click OK.

Starting the Import Pictures Wizard manually
If Windows does not automatically detect your device or other media, you can 
start the Import Pictures Wizard manually.

To start the Import Pictures Wizard manually:

 1 On the File menu, click Import Pictures.
 2 Click the device you want to use, and then click OK.
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Opening Pictures for Editing
With Picture It!, you can open pictures for editing from a variety of sources, 
including your computer, storage media, and most cameras and scanners.

Using the file browser
You can use the file browser to locate your photos and open them for editing. 
The file browser can be used to open photos from:

 The hard drive on a computer.
 A digital camera that is a USB Mass Storage Class device. (A USB Mass 

Storage Class device works as a “virtual drive,” letting you browse and 
open photos from the device as you would from a hard disk or floppy 
disk.)

 A digital photo card reader.
 A photo CD or DVD.
 A floppy disk.
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This picture identifies the main features of the file browser:

1 2 3

6 7 8 9 10

4 5

 1 All Files tab  Click the All Files tab to view the folder structure on 
your computer. Click a folder to display its contents and subfolders. The 
folder structure includes internal and external drives on your computer, 
including disk drives, card readers, and USB Mass Storage Class digital 
cameras.

 2 MSN Groups tab  Click the MSN Groups tab to open pictures that you 
have stored on MSN Groups.

 3 Look in box  Displays the name of the current folder selected on the All 
Files tab. 

 4 View menu  Use this menu to change the way the image files are 
displayed.

 5 Thumbnail size slider  Move the slider to change the size of the thumb-
nails.

 6 File name box  Displays the file name of a selected thumbnail.
 7 Files of type menu  Use this menu to change the types of image files to 

be displayed.
 8 Thumbnails  Small versions of your photos stored in the current folder.
 9 OK  Opens the selected thumbnails.
 10 Cancel  Closes the file browser without opening any photos.   



Microsoft Picture It! Photo Premium User’s Manual

10 Chapter 3: Opening and Importing Pictutes

Microsoft Picture It! Photo Premium User’s Manual

11Chapter 3: Opening and Importing Pictutes

To open pictures with the file browser:

 1 If opening pictures from a USB Mass Storage Class camera, read your 
camera’s documentation and make sure that you have installed the 
camera’s software and drivers properly. Make sure your camera is turned 
on and connected to your computer.

 2 On the File menu, click Open.
 3 Click the All Files tab.
 4 In the Look in list, click the drive, folder, or network location that 

contains the picture you want to open.
 5 In the folder list, locate and open the folder or location that contains the 

pictures.
Thumbnails of pictures in that folder appear in the right pane.

 6 Select the picture you want to open. To select multiple pictures, press 
CTRL as you click the thumbnails.

 7 Click Open.

File formats 
compatible with 
Picture It!
Picture It! can open 
photo files in any of the 
following formats:

 Adobe Photoshop 
(.psd)

 AutoCAD (.dxf)

 CorelDraw (.cdr)

 Enhanced Metafile 
(.emf)

 EPS (.eps)

 FlashPix (.fpx)

 GIF (.gif)

 Home Publishing 
(.php)

 JPEG (.jpg)

 Kodak Photo CD 
(.pcd)

 Macintosh PICT (.pct)

 Micrografx Designer 
(.drw)

 PC Paintbrush (.pcx)

 Picture It!/Digital 
Image (.png, .php, 
.mix, .fpx)

 PNG (.png)

 TIFF (.tif)

 Targa (.tga)

 Windows Bitmap 
(.bmp)

 Windows Metafile 
(.wmf)
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Opening pictures from other cameras
If your camera does not show up as a drive in the file browser, it is probably 
designed to work using TWAIN or WIA support. For many cameras, Picture It! 
works with TWAIN and WIA and your camera’s software so that you can open 
photos directly into Picture It!.

To open photos from a camera that uses WIA support:

 1 Make sure that you have installed all the drivers and software that came 
with your camera. 

 2 Connect your digital camera to your computer, and then turn on the 
camera. 

 3 On the File menu, point to Get Picture From, and then click Digital 
Camera. 

 4 Under Select a camera or drive, click a camera.  
 5 To launch the Mini Lab after opening the pictures, click Yes under After 

downloading your pictures, do you want to edit them in Mini Lab.  
 6 Click Automatic Download. 
 7 Click Download.

The pictures stored on the camera are appear in the workspace.
 8 Click Download all pictures.

- or -
To download an individual picture, drag the picture from the workspace 
to the Files palette.

 9 Click Done.

Using your 
camera’s software
Some digital 
cameras—especially 
older models—may not 
function as a virtual 
drive or be TWAIN or 
WIA compliant. For 
these cameras, use 
the software provided 
by the camera to 
download the photos to 
a folder your computer. 
Then open them with 
the file browser.
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To open photos from a camera that uses TWAIN support:

 1 Make sure that you have installed all the drivers and software that came 
with your camera. 

 2 Connect your digital camera to your computer, and then turn on the 
camera. 

 3 On the File menu, point to Get Picture From, and then click Digital 
Camera. 

 4 Under Select a camera or drive, click a camera. 
 5 Click Automatic Download. 
 6 Click Download. 

The pictures stored on the camera appear in the workspace.
 7 Click Download all pictures.

- or -
To download an individual picture, drag the picture from the workspace 
to the Files palette.

 8 Click Done. 
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Troubleshooting tips for opening pictures from a camera
 Your camera must be connected and turned on before you start the digital 

camera task, or it will not appear in the list of cameras and drives. 
 If you’ve connected your digital camera to your computer, but can’t see 

your pictures, make sure the connections are secure, the camera is turned 
on, and the batteries are charged. The camera might not start download-
ing unless its batteries are fully charged. Some cameras are equipped 
with an A/C adapter that you can use instead of batteries. 

 If your camera does not appear in the list of cameras and drives, or if you 
receive an error message when you click Download, start your camera 
software from the operating system Start menu. 

 For more information about downloading photos using the software 
included with your camera, consult your camera’s manual. 
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Opening from a scanner
Picture It! supports two types of scanner formats: TWAIN  and WIA. If your 
scanner doesn’t use a TWAIN or WIA interface, you need to use the software 
designed specifically for the make and model of your scanner. Many scanner 
manufacturers provide free updates to their drivers on the Web.

Before you attempt to scan a picture, make sure your scanner is connected 
properly. The first time you connect your scanner, the Identify Scanner Type 
dialog box will open, asking you to identify the type of scanner. 

To connect your scanner

 1 Install the software that came with your scanner. 
 2 Turn off your scanner and computer. 
 3 Attach the connector cable from your scanner to your computer. 
 4 Turn on your scanner and computer. 

Once the scanner is connected and recognized by your computer, you’re ready 
to scan.

To scan a photo with a flatbed TWAIN or WIA scanner:

 1 Connect your scanner to your computer, and then turn on the scanner. 
 2 On the File menu, point to Get Picture From, and then click Scanner. 
 3 Under Select a scanner, select a scanner.  
 4 Place your picture on the scanner. 
 5 Select Automatic Scan.  
 6 To automatically correct brightness and contrast during the scanning 

process, select the Correct brightness and contrast check box. 
 7 Click Scan. 
 8 Click Done.

About TWAIN and 
WIA
TWAIN is interface 
software that allows 
communication 
between a camera and 
your computer. Many 
digital cameras come 
with a TWAIN driver. 

WIA is a newer interface 
that works similarly 
to TWAIN, but often 
provides more control 
over the device. WIA is 
compatible with TWAIN, 
but is only available 
on some computer 
operating systems.
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Opening a Photo Sent Through E-mail
Many friends and family members enjoy sending photos through e-mail. When 
you receive photos through e-mail, you can save them to your computer and 
then work on them with Picture It!. 

Many photos sent through e-mail are low-resolution photos, which are not suit-
able for large prints. But low-resolution photos may be fine for online viewing 
or printing at small sizes.

To open a photo sent through e-mail:

Use your e-mail program to save the photo to a folder on your computer. Save 
the photo to a folder that will be easy for you to locate later, such as the My 
Pictures folder.

 1 In Picture It!, click Open on the File menu.
 2 The File Browser dialog box opens.
 3 Click the All Files tab.
 4 On the All Files tab, browse to the folder containing the photo, and then 

click the folder. 
 5 Select the photo, and then click Open.
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Opening a Picture from a Web Page
When you surf the Internet, you may come across photos and other images that 
you would like to use in your photo projects. You might find photos of celebri-
ties, vacation spots that you want to visit, or graphics that would look good as 
part of one of your photo projects. Unless the Web site uses image protection, 
you can capture these images and use them for your own projects. Web images 
are usually low resolution, so they may not be suitable for printing. But you 
could still use the images in a project to be viewed online.

To capture an image from a Web page, you can drag it from the Web page to the 
Picture It! Files palette.

To open a photo from a Web page:

 1 Make sure that both Picture It! and your Web browser (either Microsoft 
Internet Explorer or MSN Explorer) are open and running on your 
computer. 
A button for each program appears in the taskbar at the edge of your 
screen.

 2 On the Picture It! File menu, click New.
 3 Select a canvas size, and then click Done.

A blank canvas opens in the workspace.
 4 On the taskbar, click the button for your Web browser program.
 5 In your Web browser, locate the Web page that contains the picture you 

want. 
 6 Right-click the picture, and then click Copy. 
 7 On the taskbar, click the button for Picture It!.
 8 On the Picture It! Edit menu, click Paste.

The new picture appears on the canvas. 

Once the photo is opened in Picture It!, you can edit it as you would any other 
photo and save it to your computer.

Watch for 
copyrights
Pictures you see 
on the Web may be 
copyrighted, so be sure 
to read the site’s legal 
information before you 
use an image.
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Picture It! Basics

This chapter covers some of the fundamental aspects of Picture It! that you’ll 
need to get started. You’ll fi nd information on the Startup Window, the work 
area, basic image manipulation, applying text, and Help resources.  

Startup Window
The Startup Window is a quick launching point to photos, Mini Lab, projects, 
recently opened fi les, and Help. 

By default, the Startup Window   opens every time you start Picture It!. After 
closing the Startup Window, you can open it at any time from the main work 
area by clicking the Startup Window button in the Common Tasks list. This 
diagram points out the main features of the Startup  Window.

 1 Open Click the  Open button to open the fi le browser, where you can open 
photos from your hard drive, a network drive, a digital photo card reader, 
a CD or DVD, or a fl oppy disk.

 2 Open from Camera Click  this button to launch the digital camera task, 
so you can open photos from a digital camera using Picture It! or your 
camera’s software.  

 3 Scan a Picture Click this  button to launch the Scan Picture task, where 
you can scan a picture directly into Picture It!.

 4 Edit Multiple Pictures Click this  button to open the Mini Lab. The Mini 
Lab helps you perform routine editing task—such as rotating, levels auto 
fi x, cropping, and saving—on multiple pictures at the same time.  
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 5 Create a Project Click this button to pick a project design. You’ll find 
a variety of projects—such as calendars, greeting cards, and album 
pages—designed to work with your photos. Projects are organized by 
type and by theme. 

 6 Show on startup Check this box to have the Startup Window open every 
time you start Picture It!. 

 7 Help links  Click these links to go directly to resources that can help you 
get the most out of Picture It! and digital imaging. 
 Take a Tour launches the product Tour. 
 Instructional Videos displays links to the different videos available.
 Help opens the online Help window.
 Online Photo Tips links you directly to the Tips & Tricks section of 

the MSN Photos Web site.
 Register Online links you to the registration page of the Microsoft 

Web site.
 8 Recent Files See thumbnails of the last four pictures that you have edited. 

Click on one of the thumbnails to open that file.
 9 More Files Click More Files to open the file browser, where you can 

open photos from your hard drive, a network drive, a digital photo card 
reader, a CD or DVD, or a floppy disk. 

 10 Close Click to close the Startup Window and go to the main work area.
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Examining the Work Area 
Most of the photo-editing tasks you perform in Picture It! will be in the main 
work area. When you open Picture It! and close the Startup Window, you see 
the main work area. The picture below identifies the key elements of the Picture 
It! work area.

1
3

4

10

2

5 6 7 8 9

 1 Menus
Menus provide access to all of the Picture It! features. The Help menu 
gives you access to the Help window, the Instructional Videos , and the 
Picture It! Tour.

 2 Toolbar
The toolbar contains shortcut buttons for single-click access to some of 
the most common commands. To see the name of a toolbar button, hover 
the mouse pointer over the button.  

 3 Workspace Toolbar 
This toolbar contains buttons for the Tasks list, Stack, and Files palette. 
You can create more room in the workspace by hiding any of these tools.

 4 Common Tasks list
The Common Tasks list is an easy way to locate features. This list 
provides convenient access to some of the most common tasks, as well 
as single-click access to the Mini Lab, project selector, and the Startup 
Window. All of the features found in the Common Tasks list—as well as 
some additional features—are also available in the menus.

 5 Workspace
The gray area represents the workspace, the area that the canvas sits 
within. You can use the zoom controls to magnify or reduce the canvas so 
that it covers more or less of the workspace.
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 6 Selection Tools
The selection tools allow you  to work on a very specific area of an object.

 7 The canvas
The white area is called the canvas, and it represents the printable area of 
the page. When you open a photo, the canvas is often not visible since it is 
covered entirely by the picture. You can use the zoom controls to magnify 
or reduce the canvas so that it covers more or less of the workspace.

 8 Zoom controls
The zoom controls magnify or reduce your photo so that you can see it in 
more or less detail.

 9 Stack
The Stack displays a thumbnail of each object in your picture. You can 
rearrange the order of the objects by dragging a thumbnail up or down 
within the Stack.

 10 Files palette
The Files palette displays a thumbnail of all of the currently open 
pictures. You can switch your active picture by clicking a thumbnail in 
the Files palette. You can also add a picture to the one you’re working on 
by dragging the thumbnail from the Files palette to the canvas.
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Image Formatting
When you have a picture open on the canvas, there are a number of ways to 
re-size it. 

Changing picture size
When you open an image onto the canvas, the image is automatically sized so 
that it fills the workspace. As a result, a high-resolution image, such as 1600 x 
1200 pixels, will look as large as a low-resolution image that’s only 640 x 480 
pixels. For this reason, viewing a picture on the canvas is not a reliable way of 
judging an image’s resolution.

Whenever you resize an image, consider these three factors: 

 Image size, which is the size of the printed image.
 Pixel dimensions, which is how many colored dots (pixels) make up the 

picture.
 Resolution, which is the density of the pixels in the picture.

The pixel dimensions are the product of the image size multiplied by the 
resolution. For example, if you have a picture that is 4" x 6", and its resolution 
is 300 pixels per inch, its pixel dimensions would be 1200 x 1800.  Given this 
relationship, if you change one of the three settings, one of the other settings 
will also have to change to keep the mathematical relationship equal. So if you 
enlarged the picture in the previous example from 4" x 6" to 8" x 12"—and you 
kept the pixel dimensions the same—then the resolution would decrease from 
300 pixels per inch to 150 pixels per inch.

When you resize a picture, it is generally not a good idea to try to increase or 
decrease the pixel dimensions since this reduces image quality. In most cases, 
it’s not necessary to adjust the image size, since that can be handled automati-
cally during printing. For high-quality prints, it’s generally good to keep the 
picture’s resolution at least 300 pixels per inch. But depending on your printer 
model and the image quality you desire, you may be satisfied with prints at 
only 150 pixels per inch. For Web use, 72 pixels per inch is usually considered 
sufficient. 
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To resize a picture:

 1 On the Format menu, click Resize Image.
 2 Click one of the following to lock the setting:

 Image size
 Pixel dimensions
 Resolution 

 3 Enter amounts for the settings you want to change. 
 4 Click Done.
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Applying Text
You can add text to any picture and easily change the text font, font color, font 
size, alignment, and emphasis. You start by adding a text box, and then you edit 
the text in the box. A text box is its own layer on the Stack.

To add text:

 1 On the Text menu, click Insert Text.
A text box appears.

 2 Type your text. As you add text, the text box will automatically expand 
vertically to fit all of your text.

 3 To change the width of the text box, select the text box and drag one of 
the side resize handles.

 4 To move the text box, select it, hover the mouse pointer over the edge 
of the text box until the move handle appears, and then drag the move 
handle.

Once you’ve added the text, you can select the text to edit it. You can also select 
the text and use the toolbar buttons to change formatting. When text is selected, 
the following tools are available on the toolbar for formatting:

 The font menu  lets you choose between 140 different 
fonts.

 The font size menu  lets you choose font sizes from 8 to 620 points.
 The font color button  lets you choose from a standard palette of colors 

or choose a custom color.
 The Bold button  adds bold formatting to the text.
 The Italic button  adds italic formatting to the text.
 The Underline button  underlines the text.
 The Alignment button  has menu choices for Left, Right, Center, and 

Justify.
 The Bullets and Numbers button  lets you apply or cancel formatting 

for bulleted or numbered lists.
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Help Resources
There are multiple ways that you can learn more about using Picture It!. In 
addition to this User’s Manual, there is the online Help system, the product 
Tour, and Instructional Videos. The following sections describe the types of 
information available.

Online Help
Picture It! online Help is the most comprehensive of the Help resources. 
It provides step-by-step instructions, overviews, troubleshooting topics, 
technical support, and the “What’s wrong with this picture” diagnostic tool. 
Help includes several ways to find information, including a table of contents, a 
keyword index, and a full-text search.

This diagram identifies the main features of the Help window.

 1 The Show/Hide button Click this button to expand or collapse the left 
pane of the Help window.

 2 The Back button Click this button to go back to the last Help topic.
 3 The Options menu This menu has options to print a topic or to set 

options such as Internet Options, where you can change the font size in 
the Help window.

 4 The content pane Displays the current Help topic.

Accessing Help 
from the keyboard
You can access the 
online Help system at 
any time by pressing F1 
on the keyboard.
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 5 The close button closes the Help window.
 6 The Contents tab displays the Help table of contents.
 7 The Index tab lets you find keywords in the index list.
 8 The Search tab finds topics that contain words that you enter.
 9 The Favorites tab lets you save topics for quick access later.

To access online Help:

 1 On the Help menu, click Microsoft Picture It! Photo Premium 9 Help.

Using the table of contents
You can use the table of contents to locate information by subject. The table of 
contents is a useful way to see all of the features available in each category of 
features. 

To use the table of contents: 

 1 In the left pane of the Help window, click the Contents tab. 
 2 To expand a book in the contents, click the plus sign next to it. 
 3 To display a topic, in the contents list, click the topic title. 

Using the index
You can use the index when you are looking for information about a specific 
term or keyword. 

To use the index: 

 1 In the left pane of the Help window, click the Index tab. 
 2 In the Type in the keyword to find box, type the word you want to find. 
 3 In the results list, select the word you want to find, and then click Display. 
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Using the search
You can use the search function to find all the topics in Help that contain a word 
or combination of words. 

To use the search: 

 1 In the left pane of the Help window, click the Search tab. 
 2 In the Type in the keyword to find box, type the word for which you 

want to search, and then click List Topics. 
 3 In the Select Topic to display list, select the topic you want to view, and 

then click Display. 

Product Tour
The Picture It! Tour uses pictures and text to demonstrate popular features and 
new features of the program.

To take the product tour:

 1 On the Help menu, click Take A Tour.
The Tour opens, displaying icons to represent different categories of 
features.

 2 Click an icon.
A feature list appears on the left side of the window. 

 3 Click a feature. 
Graphics and text appear that explain the feature.

 4 Repeat steps 2–4 to learn about more features.
 5 To close the Tour, click Close.
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Instructional Videos 
Instructional Videos use animation and narration to show you how to use a 
variety of image editing features on your photos.

To watch an Instructional Video:

 1 On the Help menu, click Instructional Videos.
The Help window opens to a topic about Instructional Videos.

 2 Click a video title link.
The Video player opens and the Video begins. 

The Instructional Videos are accompanied by complete, online tutorials that let 
you walk through the tasks at your own pace. To open the online tutorial, click 
the Written Tutorial button on the Video player.

Technical Support 
The type of Technical Support resources available vary based on where you live 
and how you obtained your Picture It! product. 

To view Technical Support information: 

 1 On the Help menu, click About Microsoft Picture It! 9. 
 2 Click Tech Support. 





Microsoft Picture It! Photo Premium User’s Manual

315 Basic Touchup

Almost all photos can be improved with basic touchup tools. Picture It! touchup 
tools can be used to correct common photo problems such as red eye, crooked 
pictures, lighting problems or similar distractions that can ruin a photo. In 
many cases, Picture It! helps you eliminate basic problems with just a few 
clicks. 

Adjusting Brightness and Contrast
When you take a photo with an automatic camera, the camera’s automatic 
exposure feature measures the available light and determines how much light 
is required to take the photo. Sometimes, the exposure meter’s measurement is 
slightly too low or too high, creating problems with brightness and contrast in 
the photo. Picture It! provides tools to fix the levels of brightness and contrast.

To correct brightness and contrast:

 1 On the Touchup menu, click Brightness and Contrast.
 2 Click Levels auto fix.
 3 If you are not satisfied with the result of the levels auto fix, click Contrast 

auto fix.
 4 If you are not satisfied with the results, fine-tune the settings with the 

Brightness and Contrast sliders.
 5 Click Done.

The picture on the left is both too dark and too low contrast. The Levels auto fix tool was ap-
plied to the version on the right, correcting both the brightness and contrast levels.

Making a copy to 
touch up
Never edit an original 
photo. Always make 
a copy and edit only 
the copy. If you aren’t 
satisfied with the 
results, you can always 
start again by making 
another copy from the 
original.
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Adjusting Tint
When you take photographs, the source of the light can create a colored cast 
in the photo. We tend to think of light being white, but nearly every light 
source has its own unique color. For example, natural sunlight has more blue 
in it, while incandescent (tungsten) lights—including most household light 
bulbs—give off a reddish or yellowish cast. 

When taking a photo, you can compensate for these different colors of light by 
setting the white balance (with a digital camera), or using special filters (on a 
film camera). But if you still end up with a cast in your photos, use the adjust 
tint task to correct the balance of colors to make the lighting look more natural. 
In this task, you locate a point that should be white, and then Picture It! bal-
ances all of the colors in the picture based on the white point you set.

If you have already used the Levels auto fix tool, the tint problems in the picture 
may already be corrected. Use the adjust tint task to make additional adjust-
ments to the tint.

To adjust tint:

 1 On the Touchup menu, click Adjust Tint.
The mouse pointer becomes an eyedropper.

 2 With the eyedropper, click an area in the picture that should be white.
Picture It! automatically corrects the colors.

 3 If you are not satisfied with the results, use the sliders for fine-tuning. 
Set the Color slider to the color of the cast in the photo, and then use the 
Amount slider to lower the amount of that color in the photo.

 4 Click Done. 

Setting the white 
balance on a 
digital camera
Many digital cameras 
allow you to set the 
white balance for 
specific types of light, 
such as sunlight, 
incandescent, and 
flash. Using this feature 
can help reduce tint 
problems in your 
photos.

Zooming in to find 
white
If there are no 
significant areas of 
white in your photo, use 
the zoom controls to 
magnify the picture on 
the screen. When you 
zoom in, you may be 
able to use a very small 
area of white, such as 
the whites of a person’s 
eyes.
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Fixing Red Eye
Using your flash  in low light situations can give your subjects red, unnatural-
looking eyes. The Fix Red Eye tool darkens the red spots in the eyes to reduce 
or eliminate the redness. 

To fix red eye:

 1 On the Touchup menu, click Fix Red Eye.
 2 Use the pan and zoom controls to magnify your picture and focus on the 

red eyes in the photo.
 3 Click the red part of the eyes. You can click up to two eyes at once.
 4 Click Red-eye auto fix.

The redness in the eyes is removed.
 5 Repeat steps 3 and 4 as necessary.
 6 Click Done.
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Straightening a Picture
If you took a photograph while unintentionally holding the camera at an angle, 
the horizon or other straight lines will appear tilted. This tilt can be a distrac-
tion in the picture, but is easily fixed with the Straighten Picture tool.

The Straighten Picture tool rotates the picture to make the horizon level.

To make the horizon level, the Straighten Picture tool rotates the picture on 
the canvas. When rotated, part of the picture overlaps the edge of the canvas, 
and these areas would be removed during printing. The rotation also creates 
empty areas at the corners of the canvas. Fortunately, these problems are solved 
by the Auto Crop feature which is part of the Straighten Picture tool. After 
you straighten the picture, Auto Crop trims the edges of the picture so that it 
becomes aligned with the canvas.  

To straighten a picture with Auto Crop:

 1 On the Format menu, point to Straighten Picture, and then click 
Canvas.

 2 Identify a line in the picture that should be straight (such as the horizon), 
and then click one end of the line.

 3 Click the other end of the line.
The picture is automatically straightened.

 4 Make sure the Auto Crop check box is selected.
The area of the picture that will be cropped is shown in lightened color 
around the edges.

 5 Click Done.
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Cropping 
Cropping is an easy way to improve the composition of a photograph. For 
example, if your picture has distracting background elements along the top, 
bottom, or side, you can crop away these parts of the background to focus the 
attention on the subject. 

When you crop a photo, you are removing pixels, and therefore lowering the 
effective resolution (although the dots per inch will stay the same). If you crop 
a significant portion of the original, you’re limiting the extent to which you will 
be able to enlarge the picture for printing. This is why it’s better to compose the 
picture as best you can when you take it, rather than relying on heavy cropping 
later.

Cropping a picture allows you to eliminate distractions and improve the composition.

Cropping your picture to a specific proportion lets you control exactly where 
the picture will be cut. Otherwise, if your picture is not the same proportion as 
the print size, some of the picture may be trimmed during printing to fit into the 
printable area of the page. 
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Using the rule of thirds
When composing a photograph, many beginning photographers consistently 
center their subject directly in the middle of the frame. While this technique 
may be the easiest way to get the subject in focus with a point-and-shoot 
camera, it is not always the most interesting way to present the subject. 

Most advanced photographers follow the rule of thirds when composing the 
space inside a picture frame. The rule of thirds is used throughout the graphic 
design world, because it helps to create balance between the subject and the 
background. When you compose a picture according to the rule of thirds, you 
mentally divide the frame into thirds both horizontally and vertically (imagine 
a tic-tac-toe grid), and place the point of interest on one of the four spots where 
the lines intersect. 

If the photo includes a person or animal, you can place the face on one of the 
four points, looking toward the center of the scene. If the photo includes the 
horizon, it should run about one-third from the top or one-third from the bot-
tom, depending on whether the terrain or the sky is the center of focus.

The cropped picture is a more interesting composition because it follows the rule of thirds.

To crop a photo using the rule of thirds: 

 1 On the Format menu, point to Crop, and then click Canvas.
 2 Under Select a proportion, click a proportion.
 3 Select the Show guidelines for the rule of thirds check box.
 4 Click a starting point on your photo, and then drag the outline to the 

opposite corner of the area to be cropped.
The guidelines show the cropped area divided into thirds vertically and 
horizontally.

 5 Move and resize the cropped area so a focal point in the picture is 
positioned at one of the intersections of the guidelines.

 6 Click Done.
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After you have done general touch ups to your pictures, you may want to use 
advanced editing tools for more precise editing or to apply special effects. The 
selection tools and multiple-object composites give you the power to edit very 
specific areas of your pictures. You’ll also be able to transform your pictures 
with filters, color and edge effects, and specialized editing brushes. 

Understanding Objects
For many advanced photo-editing tasks, you’ll need to understand the concept 
of objects. An object is a part of a picture that can be edited individually. For 
example, when you add text to a picture, the text is a separate object from 
the background image. When you edit the text—say, making the font color 
red—the background picture remains unchanged because it is a separate object. 

Working with Composites
A picture that contains multiple objects is called a composite. The Stack helps 
you work with composites by displaying each object separately. Using the 
Stack, you can easily select any object. Make sure the Stack is showing in the 
workspace when you are working with composites.

To show the Stack:

 1 On the View menu, click Stack. 

On the Stack, you’ll see a thumbnail representation of each object in the 
composite. The top thumbnail represents the object that is the top layer in the 
composite. The bottom thumbnail represents the background object in the 
composite. Thus, the object that is lowest in the Stack may be at least partially 
obscured in the composite by the objects on top of it.

You can change the order of the objects in the composite by dragging thumb-
nails up and down the Stack. For example, dragging an object’s thumbnail 
from the lowest position on the Stack to the top position will bring it to the 
foreground of the composite.
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Locked Objects
When you open any single-object picture, such as a picture you took with your 
digital camera, the picture will, by default, be locked to its position on the 
canvas. When an object is locked to the canvas, the lock icon  is shown next 
to that object’s thumbnail on the Stack. This lock icon indicates that you will 
not be able to drag the object around on the canvas. 

To lock or unlock an object:

 1 Right-click the object’s thumbnail on the Stack.
 2 Click Lock or Unlock.
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Selecting Objects with the Object Tool
The object tool  allows you to select one or more whole objects at a time. 
With the object tool, you can move, resize, and rotate selected objects by drag-
ging the object on the canvas or using the resize handles.  

Each time you start Picture It!, the object tool will be selected by default. You 
will be able to accomplish many different editing tasks by using the object tool 
as your only selection tool. Unlike the other selection tools, the object tool does 
not have an options palette.

To select an object with the object tool:

 1 Make sure that the Stack appears in the workspace.
 2 Click the object tool  button on the toolbar.
 3 On the Stack, click the object.

When an object is selected with the object tool and not locked to the canvas, 
object handles are displayed around the perimeter of the selection. Object 
handles are yellow circles that you can drag to resize and rotate the object.

To move, resize, or rotate an object with the object tool:

 1 Select the object with the object tool as described above.
 2 If the selected thumbnail has the lock icon  displayed, right-click the 

thumbnail, and then click Unlock.
 3 To move the selection, hold the cursor over the object until the move 

handle  appears, and then drag the object on the canvas.
 4 To resize the object proportionally, hold the cursor over one of the corner 

object handles until the resize handle  appears, and then drag the resize 
handle.

 5 To stretch the object, hold the cursor over the top, bottom, or side object 
handles until the resize handle appears, and then drag the resize handle.

 6 To rotate the object, drag the rotate handle  that is attached to the top of 
the selection box.

Selecting an object allows you to edit it without affecting other objects on the 
canvas. You can select an object by clicking it, either on the canvas or on the 
Stack. If you want to select a small object or one that is hidden behind other 
objects, it is often easiest to select it on the Stack. 
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Multiple Selection, Grouping, and Flattening 
Objects
Picture It! allows you to create composites that contain many objects. While 
objects are separate, you can edit each one individually. However, sometimes 
you may want to edit two or more objects at the same time. There are three 
methods to join objects so that you can edit them together. From least perma-
nent to most permanent, the three methods for combining objects are multiple 
selection, grouping, and flattening. 

Multiple Selection
Multiple selection links objects temporarily. For example, if you wanted to 
move three objects the same amount to the left, you could select the objects, and 
then drag them together on the canvas. Then, as soon as you select a different 
object to work on, the multiple-selected objects are no longer connected.

These three objects are a multiple selection, so they can be edited as a set and then sepa-
rated later.]

To multiple select objects:

 1 Make sure that the Stack is showing. 
 2 Pressing CTRL, click each thumbnail on the Stack.

The objects become multiple selected.
 3 To cancel the multiple selection, click any single object in the Stack.
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Grouping Objects
Grouping objects allows you to edit multiple objects and then maintain the 
grouped relationship while you do other tasks. The grouping relationship 
is even preserved when you close a picture file saved in PNG Plus format. 
Grouped objects can later be ungrouped and edited individually.

These three objects have been grouped, as indicated by the group icon at the bottom of the 
selection box.

To group objects:

 1 Make sure that the Stack appears in the workspace. 
 2 Pressing CTRL, click each thumbnail on the Stack.

The objects become multiple selected.
 3 On the Edit menu, click Group. 
 4 To cancel the group, click the group on the Stack, and then on the Edit 

menu, click Ungroup.
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Flattening Objects
Flattening objects is a permanent action. If you will no longer need to edit 
objects individually, you can flatten objects into a single object. This allows 
you to work on the objects together and reduce the number of objects in your 
composite. Also, many editing tasks cannot be performed on a multiple selec-
tion. But if you flatten the objects together, they become a single object, so you 
will be able to edit them together.

To flatten multiple objects:

 1 Make sure that the Stack appears in the workspace. 
 2 Pressing CTRL, click each thumbnail on the Stack.
 3 On the Edit menu, click Flatten Selected Objects.

Automatic Flattening
When working with objects that are multiple-selected or grouped, some editing 
tasks—such as using advanced selection tools—will automatically flatten the 
selected objects into a single object. Picture It! will give you a warning message 
whenever two or more objects will need to be flattened to perform an editing 
function. When you see a warning message about flattening, you can click 
Cancel to prevent the objects from being flattened. 

Flattening Objects During Saving
When you save a composite picture in the PNG Plus file format, each object 
is preserved separately. When you open the file again, you can edit each 
individual object.

However, most file formats for images do not support multiple objects. So if you 
save a picture in the JPEG format, for example, all the objects will be flattened 
into a single object. Even if you open such a JPEG file in Picture It!, you will 
not be able to edit objects individually.
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Using Selection Tools
New in this version of Picture It! are the selection tools, which give you more 
control and more options for editing images. Selection tools allow you to fix 
problems that exist in only part of the picture. You can also use selection tools 
to create new objects that can be duplicated or pasted onto other pictures.

Selection tools help you to isolate any part of a larger picture, which enables 
you to:

 Turn part of a picture into a separate object.
 Apply filters or other effects to a limited area of a picture.
 Duplicate part of an image within a picture.
 Combine parts from two or more pictures.

The selection tools are located on the toolbar next to the Selection options 
button. There are five selection tools available, and each one works well for a 
specific editing scenario. Select the method that best fits your picture and your 
intended use. In addition to the object tool mentioned above, the other four 
selection tools are:

 Marquee tool
 Freehand tool
 Edge Finder
 Magic Wand
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The Marquee Tool
The marquee tool  helps you select part of an object in the shape of a rect-
angle, circle, or other shape. This tool is useful for cropping objects or pictures 
to a standard shape.

To make a selection with the marquee tool:

 1 Make sure that the Stack appears in the workspace.
 2 On the Stack, click the object of which you want to make a partial selec-

tion.
 3 On the toolbar, click the marquee tool button .
 4 If the Marquee Tool options palette is not visible in the workspace, click 

the Selection button on the toolbar. 
 5 To keep the edges of the selection smooth, select the Anti-aliased check 

box on the Marquee Tool options palette.
 6 On the Marquee Tool options palette, click a shape for the marquee 

selection. 
 7 To keep the marquee shape in a specific proportion, click Shape propor-

tions on the Marquee Tool options palette, and then enter a height and 
width.

 8 On the Marquee Tool options palette, choose whether you want to make 
a new selection , add to the current selection , or subtract from the 
current selection .

 9 Drag the marquee pointer diagonally across the area you want to select.
 10 To adjust the selection shape, click Adjust marquee on the Marquee 

Tool options palette, resize or rotate the marquee shape, and then click 
Done.

 11 To feather the selection, click Feather on the Marquee Tool options 
palette, enter the number of pixels that you want feathered around the 
edge, and then click OK.

 12 To select the opposite area, click Invert on the Marquee Tool options 
palette.

Anti-aliasing a 
selection
Anti-aliasing means 
that pixels on the edge 
of the selection can 
be partially selected. 
This technique helps to 
smooth the transition 
between the selection 
and the surrounding 
area. Anti-aliasing is 
useful when creating 
composites.

Feathering a 
selection
Like anti-aliasing, 
feathering a selection 
helps to smooth its 
edges. But where anti-
aliasing only affects 
pixels directly on the 
selection border, you 
can feather a border 
of up to 250 pixels 
around the edge of the 
selected area. 
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The Freehand Tool
The freehand tool  helps you select part of an object by drawing an irregu-
lar shape. 

 1 Make sure that the Stack appears in the workspace.
 2 On the Stack, click the object of which you want to make a partial selec-

tion.
 3 Click the freehand tool  button on the toolbar.
 4 If the Freehand Tool options palette is not showing, click the Selection 

button on the toolbar. 
 5 To keep the edges of the selection smooth, select the Anti-aliased check 

box on the Freehand Tool options palette.
 6 On the Freehand Tool options palette, click whether you want to make 

a new selection , add to the current selection , or subtract from the 
current selection .

 7 On the picture, drag the pointer, and then click the starting point to 
complete the selection. 

 8 To feather the selection, click Feather on the Freehand Tool options 
palette, enter the number of pixels that you want feathered around the 
edge, and then click OK.

 9 To select the opposite area, click Invert on the Freehand Tool options 
palette.
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The Edge Finder
The Edge Finder  helps you select part of an object by tracing along well-
defined edges. This tool is useful for cutting out or copying people or detailed 
items in a picture. 

 1 Make sure that the Stack appears in the workspace.
 2 On the Stack, click the object of which you want to make a partial selec-

tion.
 3 Click the Edge Finder  button on the toolbar.
 4 If the Edge Finder options palette is not showing, click the Selection 

button on the toolbar. 
 5 To keep the edges of the selection smooth, select the Anti-aliased check 

box on the Edge Finder options palette.
 6 On the Edge Finder options palette, click whether you want to make a 

new selection , add to the current selection , or subtract from the 
current selection .

 7 On the Edge Finder options palette, enter a value in the Width box. The 
Width is the number of pixels away from the pointer that the Edge Finder 
will try to detect an edge. 

 8 On the picture, click points along the edge of the item you want to select. 
As you trace, make sure that the edge stays within the zone of the Edge 
Finder.

 9 To close the selection area, click the starting point.
 10 To modify the selection, click Adjust edges, drag any point in the selec-

tion marked by a square, and then click Done.
 11 To feather the selection, click Feather on the Edge Finder options pal-

ette, enter the number of pixels that you want feathered around the edge, 
and then click OK.

 12 To select the opposite area, click Invert on the Edge Finder options 
palette.
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The Magic Wand
The Magic Wand  lets you select parts of an object that are the same or 
similar colors. The Magic Wand is useful for selecting a consistently colored 
area—a blue sky, for example—without having to trace around it. 

 1 Make sure that the Stack appears in the workspace.
 2 On the Stack, click the object of which you want to make a partial selec-

tion.
 3 Click the Magic Wand  button on the toolbar.
 4 If the Magic Wand options palette is not showing, click the Selection 

button on the toolbar. 
 5 To select only similarly-colored pixels that are connected to each other, 

select the Contiguous check box.
 6 On the Magic Wand options palette, enter a value in the Tolerance box. 

The Tolerance is the range of colors that will be included in the selection. 
 7 On the Magic Wand options palette, click whether you want to make a 

new selection , add to the current selection , or subtract from the 
current selection .

 8 On the picture, click the color you want to select. 
 9 If the selection has includes too much or too little of the area you want 

to select, enter a different value in the Tolerance box, and then make 
another selection.

 10 To feather the selection, click Feather on the Magic Wand options 
palette, enter the number of pixels that you want feathered around the 
edge, and then click OK.

 11 To select the opposite area, click Invert on the Magic Wand options 
palette.
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Editing and Copying Selected Areas
Using the advanced selection tools helps you to isolate a very specific area of 
a picture for editing or copying. For example, if a picture has generally good 
lighting levels, but a person’s face in the picture is in dark shadows, you can 
make a selection of just the face, and then adjust the brightness and contrast 
only in the selected area. And with anti-aliasing and feathering the selection, 
your edits to the selected area can look natural since the edited area will blend 
smoothly with the surrounding pixels. 

Copying, Cutting, and Pasting Selections
Advanced selection tools also allow you to cut out or copy part of an object 
to create a new object. These techniques allow you to trim a hole in a picture 
or create a new object that can be pasted in the same picture or in a different 
picture. 

To cut a hole in an object:

 1 Make sure that the Stack appears in the workspace.
 2 On the Stack, click the object you want to cut a hole in.
 3 On the toolbar, click a selection tool, and then select part of the object.
 4 On the Edit menu, click Cut.

To copy and paste part of an object:

 1 Make sure that the Stack appears in the workspace.
 2 On the Stack, click the object you want to copy part of.
 3 On the toolbar, click a selection tool, and then select part of the object.
 4 On the Edit menu, click Copy.

The selection is copied to the clipboard.
 5 If you want to paste the selection onto a different picture, open that 

picture so that it is on the canvas.
 6 On the Edit menu, click Paste.

The selection becomes a new object on the Stack.

Note: If you paste the selection onto the same picture that you copied it from, 
the new object will be in the same position and may not look like a separate 
object. But the new object will be visible on the Stack, and you can use the 
object tool to move, resize, or rotate the new object.
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Filters
The term filter originates from the colored glass covers placed over a camera 
lens. The first filters in digital imaging sought to mimic the results of these 
physical camera filters, providing a slight shift in color, or increasing the inten-
sity of colors. But the filters in Picture It! can create many other effects, from 
sharpening an image to making the picture look like a painting or a mosaic.

Three different filters were used on the original picture (upper left): The colored pencil filter 
(upper right); the watercolor filter (lower left); and the film grain filter (lower right).

To apply a filter:

 1 On the Effects menu, point to Filters, and then click a filter.

Filters create a whole new look for your pictures. Many filters make the image 
look less like a photograph and more like a drawing, painting, mosaic, or other 
hand-created artwork. Filter-enhanced pictures can become an attractive focal 
point of projects such as greeting cards and calendars. 

Waiting for filters 
to be applied
Some filters require 
your computer to make 
many calculations, so 
on a slower computer 
they may take a few 
minutes to be applied.
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Color Effects 
You can give a color picture a new look by applying a color effect. Turn a 
favorite color picture into an instant classic by changing it to black and white. 
Or, apply the antique effect, which “ages” your picture by giving it a sepia tone.

To turn a color picture to black and white or antique:

 1 On the Effects menu, click one of the following:
 Antique

  Black and White
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Paint Effects 
With the freehand paint brush, you can choose from several painting tools: 

 Paint brush
 Airbrush
 Pencil
 Eraser
 Highlighter 
 Chalk

Use these tools to add new colors to a picture.

To use the freehand paint brush:

 1 On the Effects menu, point to Paint Brush, and then click Freehand.
 2 Click a painting tool, and then click a color.
 3 Click a brush size, and then paint by dragging on the picture.
 4 Click Done.

You can paint with stamps to enliven your pictures with a rubber stamp effect, 
Choose from a variety of stamp designs or make your own. Paint with a single 
stamp design, or use multiple stamps on the same picture.

You can choose from a wide variety of stamps to customize any picture.

To paint with stamps:

 1 On the Effects menu, point to Paint Brush, and then click Stamps.
 2 Click a stamping style, and then click a stamp.
 3 Click a stamp size, and then apply the stamp by clicking on the picture.
 4 Click Done.
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Batch Editing in Mini Lab  

If you take photos regularly, it can become time consuming to perform basic 
editing to all of your pictures after you download them from your camera. Mini 
Lab contains tools that can help you save time with routine editing that needs to 
be done to many or all of the photos in a batch.

If you have a high-capacity storage medium in your camera, you may have 
dozens or more photos to download at once to your hard disk. Some of these 
photos may be excellent “keepers” that you will want to spend some time 
editing carefully later on. But many of the photos only need a few quick edits: 
changes such as rotation and removal of red eye. 

Opening each photo individually, performing basic edits, and then saving each 
one could take a lot of time. Mini Lab lets you perform these routine editing 
tasks to many photos at once. Mini Lab lets you select multiple photos to 
perform the following tasks:

 Levels auto fix
 Contrast auto fix
 Tint auto fix
 Rotate 
 Crop
 Brightness and contrast
 Fix red eye
 Save as (to save copies of the originals, change file format, and rename 

files)
 Print

Mini Lab displays all of your open photos and includes a list of editing options 
that you can perform on multiple photos. This diagram identifies the main 
features of Mini Lab.
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 1 The Open more files button opens the file browser to let you find more 
pictures to edit.

 2 The editing options list shows all of the tasks available for batch editing.
 3 File options let you save or print multiple photos.
 4 The Workspace in Mini Lab contains thumbnails of all of your opened 

pictures.
 5 The Done button closes Mini Lab, keeping the photos open and maintain-

ing the changes you have made. To save photos before leaving Mini Lab, 
select the thumbnails and click Save before you click Done.

 6 The Cancel button closes Mini Lab, undoing any unsaved changes.

To open Mini Lab from Picture It!:

 1 On the Touchup menu, click Batch Edit in Mini Lab.

After you open Mini Lab, select the photos you want to edit, and then click one 
or more editing tasks. Some of the batch editing tasks (Levels auto fix, contrast 
auto fix, tint auto fix, rotate clockwise, and rotate counterclockwise) will be 
performed to all of the selected photos at once. The other editing tasks, such as 
cropping, let you set your preferences for each picture.

Mini Lab does not automatically save your batch edits. To save your pictures, 
you can select photos and click Save. If you click Done to leave Mini Lab 
without saving, the edits will not be saved.
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Adding Edges, Mats, and Frames

When you’ve finished editing a photo, you can add polishing touches by sur-
rounding it with an edge, a border, a mat, or a frame. 

Edge Effects
Edge effects alter the outside edge of a photo. For portrait photos, try the soft 
edge effect. To draw attention to photos that you post on a Web site, try apply-
ing one of the highlighted edges.

The photo on the left has highlighted edges applied, which work great for photos on the Web 
and in e-mail. The photo on the right has been enhanced with soft edges.

To add an edge effect:

 1 On the Stack, click the layer to which you want to add the edge effect.
 2 On the Effects menu, point to Edges, and then click an edge effect or 

border.
 3 If available, click a specific edge or border.
 4 Follow the instructions on the screen to customize the size or color of the 

edge or border.
 5 Click Done.

Shrinking a picture 
to show the edge 
effect
Some edge effects 
appear only behind and 
outside the picture. So 
if your picture reaches 
the edge of the canvas, 
you might not be able 
to see the edge effect 
when you print it or 
save it to the Web. 

To make sure you can 
see an edge you’ve 
added, make sure the 
object is not locked to 
the canvas, and then 
the press the CTRL key 
while you drag in one 
of the photo’s corner 
resize handles. This 
will shrink the photo 
proportionally on the 
canvas, so that the 
border lies within the 
printable area.
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Mats and Frames
If you plan to put a photo in a traditional photo frame, you can add a Picture It! 
mat to your photo before you print it. Mats create an elegant effect, and can also 
help to fit an oddly-proportioned print to a standard size frame. 

If you don’t plan to mount a photo in a traditional frame, but would like to print 
and display it, use a Picture It! frame instead. You can choose from a variety of 
frame themes to complement the subject of your photo. You can even add both a 
mat and a frame to the same photo.

Picture It! has a wide variety of mats and frames to finish your favorite photos.

To add a mat or a frame:

 1 Select the picture or object to which you want to add a mat or frame.
 2 On the Effects menu, point to Edges, and then click Frames and Mats.
 3 Click a theme, click a design, and then click Open.
 4 Drag your photo from the Files palette into the frame or mat, and then 

click Next.
 5 Move or resize the photo so that it fits within the frame, and then click 

Done.

Choosing the right 
mat
When choosing a 
mat, consider the 
colors in your photo 
and the colors of your 
frame. A mat should 
not overpower the 
subject of the photo. Try 
selecting a soft-colored 
mat that matches 
one of the photo’s 
secondary colors. 
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Creating Projects

A great way to present your pictures and share them with friends and family is 
to create photo projects. Picture It! offers a range of designs that you can use to 
showcase your pictures. Choose from greeting cards, calendars, business cards, 
and more.

Creating Photo Cards
Use your own photo to personalize a greeting card for a holiday, a party invita-
tion, or any other occasion. 

To open a photo card design:

 1 Open a photo and check to see that it appears on the Files palette.
 2 On the File menu, click Create a Project.
 3 On the All Types of Designs page, click Cards.
 4 Click Photo Frame Cards.
 5 Click a theme, click a design, and then click Open.
 6 Follow the instructions on the screen. 
 7 To edit the inside pages, on the View menu, click Front of Card, Inside 

of Card, or Back of Card.  

Once your card project is open, you can add your own text, photos, and clip art. 
Since most printers cannot print to the edge of the page, the purple margins on 
the edges of a card project represent the unprintable areas of the card.

Working with a 
multi-page project
When working with a 
project that has more 
than one page, such 
as a greeting card, 
the multi-page palette 
appears on the bottom 
of the screen. This 
palette lets you switch 
between pages in the 
project. 
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Photo cards are either half-fold cards, which are larger cards printed on both 
sides of the paper, or quarter-fold cards, which are smaller cards printed on only 
one side of the paper. 

A favorite golfing photo was used to create this half-fold card.

To change the fold style of a card:

 1 On the Format menu, click Change Card Fold.
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Creating Calendars
Calendars are a great way to showcase your favorite photos. Calendar projects 
are available in the following formats: 

A one-week calendar A one-year calendar

A month calendar

The first three months of a 12-month calendar
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To create a calendar project:

 1 On the File menu, click Create a Project.
 2 Click Calendars.
 3 Click a calendar type.
 4 Click a theme, click a design, and then click Open.
 5 Set the start date for the calendar, and then click Next.
 6 Follow the instructions on the screen to add a photo to your calendar, and 

then click Next.
 7 Move or resize your photo on the calendar. Use the corner resize handles 

to resize the photo proportionally.
 8 Click Done.

When you create a 12-month calendar, you can add different photos to each of 
the 12 month pages.

To complete a 12-month calendar:

 1 Complete the instructions above to create a 12-month calendar.
 2 Open the photos you want so that they appear in the Files palette.
 3 Use the multi-page palette to switch between pages in the project. 
 4 Drag photos from the Files palette into each of the 12 month pages. 
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Saving and Printing Pictures

Saving Pictures
If you’re like most people, you can't stand to throw photos away, even if they’re 
imperfect. You probably have a large box or two filled with envelopes of old 
negatives and photographic prints. Keeping track of all of your old prints and 
negatives can be a formidable task. 

Fortunately, digital photography makes saving, storing, and organizing photos 
much easier. However, there are some important things you should know about 
saving your photos to make sure they’ll be in good condition whenever you 
want to enjoy them.  
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Saving Multiple Versions
Once you’ve downloaded a photo to your computer and erased it from your 
camera, your computer’s hard disk contains the only copy of that photo. This 
original version should be treated like a film negative: You don’t want to do 
anything to it that will alter the original content. Except rotation to correct 
orientation or renaming the file, the original version should be left alone.

When you want to edit a photo or add it to a project, you should always make a 
copy of the original and work with the copy. That way, if you make some edit-
ing changes that you regret later, you can always go back to the original, make a 
new copy, and start over.

To make a copy of a photo:

 1 Open the picture.
 2 On the File menu, click Save As.

The Save As dialog box opens.
 3 Click the folder where you want to save the copy of the original. 
 4 In the File name box, enter a name for the copy.
 5 Click Save.

The Save As dialog box closes, with the new copy of the picture open in 
the workspace. 
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Choosing a File Format
Picture It! allows you to save photos in a number of image file formats. You 
can determine the best format for saving your photos based on what you will 
use the photos for, compatibility with other computers, and file size. To help 
you understand the difference between file formats, here are some important 
characteristics of three common image formats:

 Picture It! PNG Plus (.png) saves the individual objects in your photo 
projects so you can edit them later. PNG offers lossless compression, but 
not all computers have the software to open PNG files.

 TIFF (.tif) is a common format for cameras that produce lossless images. 
TIFF does not support layers, but is a good format for saving important 
photos, although the files are relatively large. 

 JPEG (.jpg) is the most common format for images, since the files can 
be opened on practically any computer. JPEG does not support layers. 
Too much JPEG compression can reduce image quality, but JPEG is a 
format that makes relatively small files that work well for most purposes, 
especially for e-mail and the Web. 

To save a photo in a specific file format:

 1 On the File menu, click Save As.
The Save As dialog box opens.

 2 In the Save as type box, click a file type.
 3 Click Save.
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Setting PNG Plus Options
Only Picture It! and Digital Image can read individual objects saved in PNG 
Plus files. However, a PNG Plus file contains a flattened PNG version of the pic-
ture that can be read by many other programs, including Internet Explorer. By 
default, Picture It! saves the flattened version of the picture at the same size as 
the original, multi-object picture. But while this flattened version of the picture 
allows the file to be opened by other programs, it does increase overall file size. 

If you don’t need to have a full-size, flattened version of the picture embedded 
in each PNG Plus file, you can choose to have the flattened version of picture 
be saved at a smaller size. Limiting the dimensions of the embedded file can 
decrease the overall file size.  

To limit the size of the embedded, flattened PNG file:

 1 On the Tools menu, click Options.
 2 Click PNG Plus options.
 3 Click No Larger Than, and then enter values to limit the width and 

height. 
 4 Click OK, and then click OK.
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Saving for E-mail and the Web
Unlike photos for printing, photos for e-mail and the Web work best if they are 
relatively low resolution. Low-resolution photos, such as one that is 440 x 330 
pixels, move faster through dial-up modems, and they are the right dimensions 
for viewing on most computer monitors.  

To save a photo for e-mail or the Web:

 1 On the File menu, point to Save a Copy For, and then click Save for 
E-mail or Web. 

 2 Do one of the following:
 Click a picture size
 Set maximum dimensions

 3 Click Save As.
The Save As dialog box opens.

 4 Click the folder to which you want to save the photo.
 5 In the File name box, type a file name, and then click Save.

Avoid sending 
large photos in 
e-mail
Sending high-resolution 
photos in e-mail may 
cause problems for your 
recipients. For example, 
a single 5-megabyte 
(MB), high-resolution 
image will take over 20 
minutes to download on 
a 28.8-Kbps modem. 
Also, some e-mail 
programs limit the 
size of attachments, 
and may, for example, 
block e-mail with 
attachments larger 
than 1 MB.
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Printing Pictures

Printing Single Pictures
Picture It! has a simple process for printing single images. When using the 
single-picture printing task, one copy of the picture will print on the page, and 
the picture will be centered on the paper. 

To print a single picture:

 1 Make sure your printer is turned on and connected to your computer.
 2 On the File menu, click Print.
 3 Under Select a printer, click a printer.
 4 To specify printer settings, click Change printer settings.
 5 Select the number of copies, and then select a print size.
 6 Click an orientation, and then click Print.

Printing Multiple Pictures
Picture It! has a wide variety of templates that allow you to print multiple 
pictures on a page. You can print multiple copies of the same picture or multiple 
pictures together at the same time. 

Printing on a multi-photo sheet saves paper and is a convenient way to create prints to give to 
family and friends.

Installing printer 
drivers
When adding a new 
printer, make sure that 
you install all the printer 
software and drivers. 
If you’re installing an 
older printer, you may 
be able to find updated 
printer drivers on the 
manufacturer’s Web 
site.



Microsoft Picture It! Photo Premium User’s Manual

66 Chapter 10: Saving and Printing Pictures

Microsoft Picture It! Photo Premium User’s Manual

67Chapter 10: Saving and Printing Pictures

To print multiple photos on the same page:

 1 Make sure your printer is turned on and connected to your computer.
 2 Open all the pictures that you want to print so that they are on the Files 

palette.
 3 On the File menu, click Print.
 4 Under You can also, click Print multiple pictures or special paper.
 5 Under Select a printer, click a printer.
 6 To specify printer settings, click Change printer settings.
 7 Select a category of page layout, and then click an orientation.
 8 Click a layout in the right pane, and then click Next.
 9 Drag pictures from the Files palette onto the layout.
 10 Click an option for fitting the selected picture to the area, and then click 

Next.
 11 Preview the page layout, and then enter the number of copies you want to 

print.
 12 Click Print.
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Selecting Print Quality
Most desktop printers are capable of printing in a range of qualities, from a 
low-quality draft mode to a high-quality setting that requires more time and 
uses more ink. Printer settings for quality and color vary, but you may be able 
to specify your paper type, ink type, dots per inch required, and color manage-
ment preferences. Some printers have simplified printing options such as 
“Good,” “Better,” and “Best.” Make sure to read your printer’s manual to find 
out how to take advantage of these different settings.

To select print quality for your printer:

 1 On the File menu, click Print.
 2 Click Change printer settings.

Your printer’s dialog box opens. 
 3 Adjust your printer’s quality settings, and then click OK.

Turning on color 
management
Check your printer’s 
manual to see 
if it offers color 
management. Color 
management can help 
your printer to produce 
colors that match the 
ones on your monitor. 
If your printer offers 
color management, 
click Change picture 
settings while 
performing the Print 
task. Your printer’s 
dialog box will open, 
and you can adjust 
the settings for color 
management.



Microsoft Picture It! Photo Premium User’s Manual

68 Chapter 10: Saving and Printing Pictures

Microsoft Picture It! Photo Premium User’s Manual

69Chapter 10: Saving and Printing Pictures

Selecting a Print Size
The quality of photo prints is directly related to the number of pixels in the 
picture. A high-resolution picture contains a lot of detailed visual information, 
and can be printed at larger sizes. For example, a picture whose dimensions are 
2048 x 1536 pixels (3.1-megapixel) would look good even when printed as large 
as 8" x 10" on most printers. 

A low-resolution picture has less detailed visual information, and therefore can-
not be printed in larger sizes. A picture with pixel dimensions of 1280 x 960, 
for example, lacks the detail needed to fill an 8" x 10" print. The result would be 
a grainy, pixelated image. But printing this picture at a smaller size, such as 4" 
x 6", would give you a sharp, detailed print.

Choosing Photo Paper
If you want your images to look like traditional photographs, choose paper that 
is clearly labeled as photo paper. Photo paper comes in a range of thicknesses 
and textures. Paper weight ranges from ordinary office-document weight to 
fairly heavy watercolor paper. If you choose a heavyweight paper, check your 
printer’s manual to make sure that your printer can handle it. 

The quality of the image will be affected by the kind of paper stock you choose. 
As a rule, you’ll see the widest range of colors and get the deepest blacks from 
paper that has been specially coated to accept inkjet inks. The range of colors 
appears to be widest on the whitest papers. Glossy surfaces also create the 
illusion of deeper blacks. However, if you’re going to display your prints, glossy 
surfaces can cheapen the look of the work, and surface glare can make the 
images more difficult to view.

Paper formulations also contribute greatly to resisting fading and color shifting. 
If you’re using “fade-resistant” or “archival” inks, look for coated, acid-free 
papers that are also advertised as fade-resistant or archival.
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Creating Long-lasting Prints
How long can you expect a print to last? With some inkjet prints, you can only 
expect a fade-free lifespan of two months to two years. All of the major printer 
manufacturers are beginning to advertise greater image stability for the output 
of certain printer/ink combinations, but few of these manufacturers claim that 
prints will last more than about four years. 

When buying supplies for your printer, check which types of ink and paper are 
recommended by the manufacturer of your printer, and find out about the ink’s 
lifespan rating. Some six-color printers use inks specially formulated for long 
life. When printed on high-quality heavyweight matte paper, photos from these 
printers can last approximately 40 years before perceptible fading occurs.

Fade ratings are given as the amount of time before any color shift in the print 
can be seen by the naked eye. The actual time it would take for the print to 
become unacceptably discolored would be several times that. These ratings are 
based on indoor exhibition under glass in an atmosphere that is not chemically 
polluted. Ozone is especially harmful to dye-based printing inks. Do not 
display these prints in rooms where oxygen tanks or electric air fresheners are 
used—both produce high levels of ozone. 
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Ordering Prints and Gifts on MSN Photos
Order prints of your photos online at MSN Photos and have the prints sent to 
you or your family and friends. On MSN Photos, you can also use your photos 
to create a variety of photo gifts.

To order prints and enlargements:

 1 On the File menu in Picture It!, point to Print Professionally Online, 
and then click Prints and Enlargements. 

 2 Choose to print either the current picture or all opened pictures in the 
Files palette.

 3 To open additional photos for ordering prints and enlargements, click 
Add or remove pictures, and then follow the instructions on the screen.

 4 Click Next. 
 5 Follow the instructions on the screen to order the prints and enlargements 

you want. 
 6 Click Done.

To order photo gifts:

 1 On the File menu in Picture It!, point to Print Professionally Online, 
and then click Photo Gifts. 

 2 Choose to print either the current picture or all opened pictures in the 
Files palette.

 3 To open additional photos for ordering prints and enlargements, click 
Add or remove pictures, and then follow the instructions on the screen.

 4 Click Next. 
 5 Order the photo gifts you want. 
 6 Click Done.
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Taking Great Pictures

No matter how polished and creative you are as a photographer, Picture It! is a 
valuable tool for helping you get the most out of your photos. With Picture It! 
features, you can easily correct common photo problems such as red eye and 
overexposure. And you can use features like filters and layers to create photos 
strikingly different from your originals.

Although Picture It! is a powerful photo-editing program, it’s important to get 
the best photo you can at the time you take it. Picture It! can do a lot to correct 
minor problems with the originals, but certain problems, such as severely 
blurred or underexposed photos, cannot easily be fixed with computer software. 
And if you can develop your photography skills to take higher-quality photos, 
you can spend your time doing creative photo editing with Picture It!, rather 
than fixing mistakes that can be avoided. 

Many cameras available today offer a high degree of automation: just turn 
the camera on and press the shutter, and the camera does the rest. While this 
approach is quick and easy, it isn’t perfect in all situations. As a photographer, 
you can learn to fine-tune the settings on your camera to gain greater control of 
the camera to get the best possible photo for each situation. 

With the range of cameras available—from basic point-and-shoot models 
to professional SLR (single-lens reflex) cameras—this chapter cannot cover 
specifics for all features available on all cameras. But this chapter does provide 
a foundation of photography concepts that are vital to taking consistently good 
photographs.

The first section of this chapter contains information specific to digital cameras: 
concepts such as resolution and compression that don’t have direct counterparts 
in film photography. Later sections cover universal photography concepts that 
apply to both film and digital cameras.

Opening photos 
from your digital 
camera
For information on 
opening photos from 
your camera in Picture 
It!, see the digital 
camera section in the 
“Opening Photos in 
Picture It!” chapter. 
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About Digital Cameras
If you’re new to using digital cameras, several camera features may seem 
foreign to you. Some of these features, such as digital zoom and compression, 
did not exist with film cameras because the technology did not exist. But it’s 
important to understand what these features do and when it’s appropriate to use 
them (or, in some cases, not use them).

Photo Quality
A digital photograph is composed of tiny colored squares called pixels (short 
for picture elements). Like a mosaic, the pixels blend together to form a picture. 
Each digital photo consists of a set number of pixels, ranging from a few 
thousand to millions. When a digital camera takes a photo, it creates a digital 
file that specifies the number of pixels and the precise color of each pixel.

Pixels are not a set size, so they can shrink or enlarge if photo size changes. 
When a photo is enlarged too much, the individual pixels become visible, mak-
ing a poor-quality photo. 

The original photo on the left was saved at high resolution, and you can see sharp detail. The 
photo on the right has been saved at such low resolution that you can see the individual pixels.

The number of pixels that make up a photo is the photo’s resolution. Resolution 
and compression are key factors in determining the quality of a digital photo. 
The following sections explain resolution and compression.  
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Resolution
Resolution is one of the main determinants of photo quality since it is a 
measure of the total number of pixels that make up a photograph. Resolution 
is sometimes expressed as the total number of pixels, such as 3 megapixels (3 
million pixels), or in pixel dimensions, such as 320 x 240 (which equals 76,800 
total pixels). 

Resolution is important primarily because it determines how much you can 
enlarge and print a photo. Everything else being equal, a 3-megapixel photo 
and a 320 pixel x 240 pixel photo look the same in a wallet-size print. But if you 
enlarge those two photos to 5" x 7" prints, the quality of the 320 x 240 photo is 
very low: you can see the individual pixels. The 3-megapixel photo still looks 
sharp at the larger size, since its pixels are too small to be seen.

Resolution is also important because it determines file size. High-resolution 
photos contain color information for many more pixels than low-resolution 
photos, so the files for high-resolution photos can be significantly larger. File 
size becomes an issue if you have limited storage on your camera or hard disk, 
or if you need to send the photos through e-mail.

The following chart gives an estimate of file size and maximum print size for 
various resolutions. The chart lists file sizes for JPEG format, which is a com-
mon (but not the only) format for photos. 

  Approx. JPEG file size 
Dimensions Total pixels (with slight compression*) Maximum print size

320 x 240 76,800 23 KB Wallet size

640 x 480 307,200 91 KB 4" x 6"

1280 x 960 1,228,800  363 KB 5" x 7"
 (1.2 megapixels)

1600 x 1200 1,920,000  576 KB 8" x 10"
 (1.9 megapixels)

2,048 x 1,536 3,145,728  970 MB 11" x 14" and larger

 (3.1 megapixels)

* Compression, which is explained in the following section, varies by camera, so you may find different file 
size results.

Instead of film, a digital camera uses an image sensor—usually a CCD 
(charge-coupled device) or CMOS (complementary metal oxide semiconductor) 
chip—to capture the visual information when you take a photo. The image sen-
sor on a simple, low-resolution camera might capture just over 76,000 pixels. 
The image sensor on a high-quality digital camera might capture more than 
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6 megapixels. As you can imagine, the 6-megapixel camera can produce very 
large, high-quality photos (with very large files). The 76,000-pixel camera can 
capture a relatively small number of pixels, so photo quality would be fair to 
poor, even at small print sizes.

On many cameras, you can set the resolution at which the image sensor 
captures the photo. As a rule of thumb, always shoot at the highest resolution 
possible—you’ll get higher-resolution photos that you can print in larger sizes. 
However, in some cases you may want to lower the resolution so that the files 
will be smaller. This allows you to store more photos on the camera’s storage 
media, but you must sacrifice some quality for quantity.

Make sure to check your camera’s manual to find out what resolution you will 
get from the photo-quality settings on your camera. Beware of settings that 
offer “enhanced” or “interpolated” resolution. These features add extra pixels 
not found in the original photo to produce a higher-resolution photo, which may 
reduce overall sharpness or quality.

Megapixel rating
One of the main factors 
in the price of a digital 
camera is its megapixel 
rating. The megapixel 
rating indicates the 
maximum number of 
pixels (in millions) that 
are captured by the 
camera’s image sensor.
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Compression
You’ve seen one way to reduce photo file size: lower the resolution at which you 
shoot the photo. You can also reduce file size by having the camera compress 
the photo file as it saves the file to the camera’s memory. Compression consoli-
dates similar information in the photo, and discards some information. With 
JPEG compression, for example, series of similarly colored pixels are grouped 
together and considered to be the same color. In the code that makes up the file, 
the color information for these grouped pixels only has to be listed once instead 
of hundreds, or even thousands, of times. This shortcut can reduce file size 
considerably. Taken to extremes, a photo in highly compressed JPEG format 
might be 95 percent smaller than the same photo in an uncompressed format.  

Although compression does reduce file size, it also reduces photo quality. Slight 
to moderate compression might not noticeably reduce photo quality, but high 
compression produces visible areas of splotchy color called artifacts. Even with 
slight compression, artifacts become more pronounced each time the photo is 
saved and compression is applied.

The left photo has been saved with lossless compression, so all of the image quality is 
retained. The photo on the right was saved with heavy JPEG compression—which is not loss-
less—and the compression significantly reduced the image quality.

For important photos that you want to make into prints, it’s good practice to 
use little or no compression. Or, if your camera offers it, you can take your 
photos in a format, such as TIFF, that offers lossless compression. Lossless 
compression reduces file size, but retains all of the photo quality once the photo 
is restored.    

File size and photo 
quality
Lowering resolution and 
increasing compression 
both reduce file size 
and photo quality. 
Bearing this in mind, 
you can use file size as 
a rough way to judge 
photo quality.
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File Formats
There are many file formats designed for photos or other digital images. Picture 
It! can work with JPEG, TIFF, and many other file formats. If your camera 
allows you to choose file formats for your photos, you can decide which format 
to use based on your particular criteria: photo quality, file size, or compatibility 
with other programs.

The JPEG format is the most common format for photos. JPEG files are versa-
tile, since they can accommodate over 16 million colors, can be compressed, 
and can be viewed in any Web browser. To reduce file size, the JPEG format 
always uses compression, although the degree of compression varies by camera. 
Experiment with the compression settings on your camera to find a low-
compression setting that produces good or excellent results. Because JPEG uses 
some compression every time a file is saved, many photo purists prefer formats 
like TIFF over JPEG. 

The TIFF format provides an extremely accurate recording of digital-image 
data. Some cameras can use a lossless compression method with TIFF. But even 
with some compression, TIFF files are generally larger than JPEG files for pho-
tos with the same resolution. For example, a single uncompressed 5-megapixel 
TIFF image is larger than 10 MB. To work with photos of that size, you need a 
lot of memory on your computer as well as a high-volume storage disk.   

File formats 
compatible with 
Picture It!
Picture It! can open 
photo files in any of the 
following formats:

 Adobe Photoshop 
(.psd)

 AutoCAD (.dxf)

 CorelDraw (.cdr)

 Enhanced Metafile 
(.emf)

 EPS (.eps)

 FlashPix (.fpx)

 GIF (.gif)

 Home Publishing 
(.php)

 JPEG (.jpg)

 Kodak Photo CD 
(.pcd)

 Macintosh PICT (.pct)

 Micrografx Designer 
(.drw)

 PC Paintbrush (.pcx)

 Picture It!/Digital 
Image (.php, .mix, 
.fpx)

 PNG (.png)

 TIFF (.tif)

 Targa (.tga)

 Windows Bitmap 
(.bmp)

 Windows Metafile 
(.wmf)
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Using Zoom Features
A zoom lens lets you adjust the focal length of the lens, making your subject 
appear closer to or farther from the camera. Some cameras have built-in 
adjustable zoom lenses; others accommodate interchangeable zoom lenses of 
different focal lengths. 

Digital cameras may offer optical zoom or digital zoom. An optical zoom 
feature uses the same principle as a zoom lens on a film camera: the lens itself 
moves to change the focal length. In any of the zoom positions, the resulting 
resolution is the same. 

A digital zoom feature does not move the lens. Instead, the software inside the 
camera crops the photo to make the subject appear closer. Because the pixels 
are removed from the area that’s cropped out, the overall resolution is lower. 
Many cameras offer a combination of optical and digital zoom. For best results, 
use only optical zoom. Then, if necessary, use Picture It! to crop the photo.

Both “digital zoom” and “enhanced resolution” features use interpolation to 
add pixels to the original photo, a process that increases the overall size or 
resolution. Interpolation assigns colors to the added pixels based on the colors 
of the surrounding pixels. While these features technically do increase resolu-
tion, they do not achieve the same photo quality as a photo that has not been 
interpolated. If your camera has digital zoom or enhanced resolution, test it and 
make sure you like the results before you use it for important photographs. For 
true zoom capability and highest image quality, use optical zoom.

Expand your 
perspective
Zoom lenses are great 
for capturing objects 
you can’t get close to, 
such as a ship sailing 
in water far from the 
shore. Use a zoom lens 
to get close-up, candid 
shots of people without 
seeming intrusive or 
conspicuous.
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Memory Cards, Disks, and Sticks
After the image sensor captures a photo in your digital camera, the digital 
information is stored on removable media, such as a CompactFlash or Smart-
Media card, a memory stick, a floppy disk, a CD, a microdrive, a miniature 
storage card, or a secure multimedia card.

Floppy disks and CDs have the advantage of being inexpensive and easy to 
find, even if you’re traveling abroad. Floppy disks, however, have very limited 
storage capacity.

Memory cards are small, durable, and reusable. And storage technology has 
been steadily improving, so you can now find cards that store as much as 1 
gigabyte (GB). Memory cards can be reused over and over, which, over time, 
makes them less expensive than film .

Buying additional storage media, like these CompactFlash cards, allows you to take many 
more photos in a single session.

Storage media size dictates how many photos you can store. The media that is 
included with some cameras can only hold a few high-resolution photos. This 
type of low-capacity card can be impractical for situations such as traveling. To 
give yourself more flexibility, you may want to purchase additional removable 
storage media.
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Battery Life
Compared to film cameras, many digital cameras use batteries at a surprising 
rate. The LCD preview screen and the flash on the camera both put a heavy 
drain on the batteries. And unlike some manual film cameras, digital cameras 
cannot function without batteries or an AC power adapter.

To ensure longer shooting, you can buy rechargeable batteries, which last longer 
than disposable alkaline batteries. Keep your spares charged so they’ll be ready 
when you need them. If you are running low on power and don’t have a spare 
battery, conserve remaining power by trying the following:

 Turn off your LCD screen and compose through the viewfinder.
 Turn off your flash so that it doesn’t fire automatically. Turn the flash on 

only when you really need it.
 Wait until you’re home to preview your photos.

The best 
rechargeable 
batteries
Lithium-ion batteries 
and nickel metal 
hydride (NiMH) 
batteries both 
work very well with 
cameras, providing 
excellent power and 
convenience. 
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Using the Flash
Learning to use the flash is one of the easiest ways to get better photos both 
indoors and outdoors. Especially when you’re photographing people, overpow-
ering light from the flash can ruin the shot, often in ways that are difficult to 
correct with photo-editing software.

Most inexpensive and moderately priced cameras come equipped with a built-in 
flash. The flash may be programmed to go off automatically when the camera 
senses that the flash is needed. But relying on the camera’s judgment will not 
always give you the best results. Built-in flashes can create harsh shadows, 
overexposed areas, and unnatural-looking light.

Read your camera’s manual to learn what the recommended flash range is, and 
to find out how to adjust different flash settings. Three of the most common 
flash settings are outlined in the following sections.

Automatic Flash
Contrary to what you might think, you may be better off without your flash in 
many situations. If you think the scene is too dark to take without a flash, try 
increasing the ambient light by turning on lamps and opening the drapes. On 
most digital cameras, you can increase the ISO equivalent setting, in effect 
making the image sensor more sensitive to the available light, which allows you 
to shoot in low light without a flash.

Many newer cameras offer low-light shooting modes and night-flash settings 
that improve the quality of low-light photos. If your camera offers these 
options, use them. Otherwise, always stay within the recommended range of the 
flash.

Upgrading your 
flash
If your camera supports 
an external flash, 
consider buying one, 
especially if you take 
a lot of indoor photos 
of people. An external 
flash will give you much 
more control and often 
better results.

The range of your 
flash
Check your camera’s 
manual to find out the 
recommended range 
for your flash. Most 
on-camera flashes are 
designed to illuminate a 
subject that is 10 to 15 
feet from the camera. 
If the flash is too close, 
your subject may look 
too bright or washed 
out in the photo. If 
you’re too far away, the 
flash doesn’t provide 
enough light.
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Red-Eye Reduction Flash
One of the most common problems with flash photos of people and pets is red 
eye. This problem is caused by a flash located very close to the camera lens. 
The light from the flash reflects off the blood vessels in the subject’s retina, 
causing the pupils to look red. This problem occurs frequently in low-light 
situations, when pupils are likely to be dilated. There are several things you can 
do to help avoid red eyes in your photos:

 Increase the ambient light in the room. Turning on lights and opening up 
the drapes reduces the size of your subjects’ pupils.

 Use your camera’s red-eye reduction setting. This feature fires preflash 
bursts that help reduce the dilation of the pupils before the exposure.

 If you have an off-camera flash, move it away from the camera lens. 
Then, even if your subjects’ pupils are dilated, the light comes from a 
different angle and reduces or eliminates the red-eye effect.

Fixing red eye with 
Picture It!
If you end up with red 
eyes in your photos, 
Picture It! makes it 
very easy to remedy 
this problem. For more 
information, see the 
section on removing 
red eye in this book’s 
“Basic Touchup” 
chapter.
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Fill Flash
You can use the fill flash setting to fill in deep shadow areas caused by bright 
overhead sunlight, or in a scene where the light is behind the subject. 

In the left photo, the strong backlighting creates a shadow that covers the subject’s whole 
face. For the photo on the right, fill flash was used to counteract the backlighting and keep the 
shadows off the subject’s face.

If your flash is using the automatic setting, bright daylight can prevent it from 
firing. Turn on the flash manually, or, if your camera has a fill-flash setting, 
turn it on. If you see shadows on your subjects’ faces as you’re composing the 
shot, fill flash is a good idea.

An alternative to using the fill flash is moving to a different place where the 
light from the sun is diffuse and indirect, which produces a softer, more flatter-
ing portrait light.
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Using Your Camera’s Manual Settings
In today’s camera marketplace, the lines between manual and automatic cam-
eras have become blurred. It used to be that manual cameras were 35mm SLR 
(single-lens reflex) cameras with manual controls for focusing, aperture, shutter 
speed, and film speed. On the other end of the spectrum were fully automatic 
cameras with very limited controls, possibly only a shutter button. 

For serious camera users, the manual SLR cameras were usually the best 
option, since they offered so much control. The creative process was not left to 
the automatic settings of a camera. Automatic point-and-shoot cameras were 
good for novice photographers who didn’t want to worry about setting the cam-
era controls. Many automatic cameras could produce adequate or even excellent 
photos without requiring knowledge of advanced photography concepts. 

While you can still find fully automatic and fully manual cameras, many of 
today’s cameras offer different modes for different degrees of automatic and 
manual control. For example, some SLR film cameras let you switch to an auto-
matic mode where the camera determines everything from focusing to setting 
the aperture. Many compact digital cameras are designed to be used primarily 
in automatic mode, but also allow you to switch to program and manual modes 
to control exposure settings, like shutter speed and aperture. 

With digital cameras, the adjustments that you make are often digital approxi-
mations of the equivalent function in film cameras, as with shutter speed or 
ISO. But the photographic result is the same. The following sections provide an 
overview of the most important manual camera settings and concepts. 

Exposure
Exposure describes the amount of light that comes into your camera when you 
take a photo. Setting the camera to the correct exposure is crucial to getting the 
proper tones and colors in your photos. Overexposure occurs when too much 
light has reached the image sensor (or film in a film camera), which decreases 
detail and causes the photo to look washed out. Underexposure occurs when 
insufficient light has been let into the camera, and the photo looks dim and 
murky.

Exposure is controlled by three factors: the aperture, the shutter speed, and the 
ISO rating. Aperture is the size of the opening that lets light into the camera. 
Shutter speed is how long light is allowed into the camera. ISO rating (the film 
speed in a film camera) is the sensor or film’s sensitivity to light.
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The water glass analogy

When taking a photograph, your goal is to achieve a perfect exposure. To create 
the right exposure, you need to understand the relationship between the three 
exposure factors: aperture, shutter speed, and ISO rating. Achieving perfect 
exposure can be compared to filling a glass completely without spilling any 
of the water. For a perfect exposure, the glass should become completely full 
with no water spilling over. In this analogy, the tap symbolizes the aperture: 
the wider the tap is open, the faster the glass fills up. The time that the tap is 
open represents the shutter speed: leaving it open longer lets more water into 
the glass. To fill the glass to exactly the right level, the rate of flow must be set 
according to the time the tap is open. 

The third factor, ISO rating, can be equated to the size of the water glass. A 
smaller glass, representing a faster ISO rating, fills up more quickly than a 
larger glass, representing a slow ISO.

Understanding automatic exposure
As a photographer, you will come across a wide range of lighting conditions, 
and each condition requires that you adjust your camera to different exposure 
settings. For example, shooting a photo on a beach on a sunny day calls for 
different exposure settings than shooting on the same beach on a cloudy day.

For many conditions, the camera’s automatic exposure setting gives you good 
or even excellent results. But for some situations, the automatic exposure does 
not perform as well.

Automatic exposure assumes that the scene you are photographing has a few 
bright spots, many midtones, and a few dark areas. As the camera’s meter reads 
the available light in your scene, it averages the light in the bright, middle, and 
dark areas, and then calculates the exposure necessary to bring the average 
level to a tone of medium brightness called middle gray. 

Automatic exposure does not work well if your scene is dominated by large 
sections of very light or very dark colors. A bright field of snow, for example, 
has so much bright light that the automatic exposure lowers the brightness until 
the snow looks gray. To work around this shortcoming, you can use exposure 
compensation.
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Exposure Compensation
Some cameras have an exposure compensation feature that lets you manually 
override the automatic exposure setting. Exposure compensation lets you adjust 
the exposure with settings such as +2, +1, -1, and -2. A +1 setting, for example, 
tells the camera’s automatic exposure system to make the middle tones brighter. 
When taking a photo dominated by bright snow, increasing the exposure with 
the +1 setting might correct the light level for the snow-filled scene. Your actual 
results will vary according to your camera and the brightness of the day. 

With bright snow in a scene, setting your camera’s exposure compensation setting to +1 or +2 
might help you to get the right exposure.

Aperture
The aperture is the opening through which light passes to reach the film, or, in 
digital cameras, the image sensor. Aperture is measured by f -number, where 
a specific setting is called an f-stop. With f -stops, a low number, such as f/4, 
represents a wider opening that lets in more light. A small aperture, such as 
f/16, lets in significantly less light. 

Some cameras have a fixed aperture that can’t be adjusted. If you’re adjusting 
the aperture yourself, a setting of f/8 is a good place to start, since it gives you a 
fairly wide zone of sharpness.

If your camera allows you to adjust the aperture, use the settings to regulate the 
depth of field in your photo. Depth of field refers to the zone in your photo that 
is in acceptably sharp focus. A wide aperture gives you a shallow depth of field, 
while a small aperture allows a very deep zone—maybe even everything in the 
photo—to be in focus. 

Increasing your 
chances with 
bracketing 
If you’re not sure 
what the best 
exposure setting is, try 
bracketing. Bracketing 
involves taking 
multiple photos of the 
same scene. Start by 
using the automatic 
exposure, and then use 
exposure compensation 
to take additional 
frames with increased 
and decreased 
exposure levels. With a 
series of photos taken 
at different settings, 
there is a good chance 
that one has the 
exposure just right.

Program modes
If your camera offers 
program modes for 
specific photos like 
portraits or action 
shots, read your 
camera’s manual to 
find out the aperture 
settings used for those 
modes.
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Imagine pointing your camera down a set of railroad tracks which go all the 
way to the horizon. With a wide aperture, like f/2.8, if you focus on a railroad 
tie a short distance away, only a few of the other ties are in sharp focus. With a 
narrow aperture, like f/22, many more of the ties are in focus, even those quite 
a distance from your main focal point.

A wide aperture will give you a short depth of field, as illustrated in the photo on the left, where 
only the eagle is in focus. The photo on the right was taken with a small aperture, so almost 
everything is in focus.

For portrait photography, a wide aperture helps to limit the focus. Your 
subject’s face is clear and sharp, but objects in the background are blurred. But 
if you’re shooting a vacation photo of someone posing in front of a monument, a 
narrow aperture may be in order. With the narrow aperture, both the person and 
the monument can be in focus in the same photo. 

Of course, adjusting the aperture also affects how much light is let into the 
camera. But if a specific depth of field is important for your shot, you can 
switch to manual mode, set the aperture, and then set the shutter speed to get 
the correct exposure level. Some cameras also offer an aperture priority mode 
that automatically selects the correct shutter speed to produce the correct 
exposure for the aperture you select.
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Shutter Speed 
In most cameras, the shutter is the curtain in front of the film or image sensor 
that is retracted for a precise amount of time to let light into the camera. Shutter 
speed can be adjusted to let light into the camera for a longer or shorter amount 
of time. 

When determining the correct exposure for a photo, both shutter speed and 
aperture must be considered in relation to each other. An increase in shutter 
speed, which lessens the time the film is exposed to light, requires that you 
widen the aperture to let in more light.

Shutter speeds are measured in fractions of seconds. In automatic mode, 
many cameras will use a shutter speed of about 1/125th of a second. For action 
photography, a very fast shutter speed, like 1/500th of a second, can help to stop 
action and reduce blurring caused by movement of your subject. 

A fast shutter speed like 1/250th of a second can help you freeze action.

On the other extreme, you might set the shutter to stay open for four seconds, or 
even more for low-light night photography without a flash. But shutter speeds 
slower than 1/30th of a second increase the likelihood that slight movements in 
your hand while you take the shot will cause a blurred photo. To avoid camera 
shake, mount your camera on a tripod or other firm surface for slow shutter 
speeds.  

Shutterless 
cameras
Many digital cameras 
do not even have a 
true shutter. Instead, 
the image sensor is 
programmed to control 
the exposure time. The 
effect of shutter speed 
control is the same as a 
physical shutter.
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To accommodate the low light of this twilight scene, the camera was mounted on a tripod and 
set to a slow shutter speed.

Some cameras offer a shutter priority mode that sets the aperture automatically 
after you set the shutter speed. This can be useful if you’re in a situation where 
shutter speed is more important than aperture, like when you’re shooting a 
subject in motion.  
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ISO Setting or Equivalent
When shooting on film, you have the opportunity to select different types of 
film for specific uses. Films are available in different speeds that are more 
sensitive or less sensitive to light. 

The film speed is measured by ISO number. A high-speed film, such as ISO 
800, is ideal for low-light situations or action photography, since the film 
requires less light to properly expose the photo. Slow-speed films, such as 
ISO 100 or ISO 200, are good for photographing in bright daylight, since they 
require a lot of light. If you plan on using the same roll of film for shooting in 
multiple settings and light levels, ISO 400 film is a good compromise and does 
relatively well in most situations.

Faster films generally produce grainier photos than lower-speed films. Some of 
the newer varieties of professional grade high-speed films produce a finer grain 
structure, which is less noticeable. 

Since digital cameras use an image sensor instead of film, there is no way 
to actually change the film speed. However, many digital cameras provide 
the digital equivalent of an ISO. Sometimes called the sensitivity setting, this 
feature allows you, in effect, to change the ISO setting. For example, if you are 
shooting in a low-light situation, you can switch from ISO 100 to ISO 400.

With most digital cameras, setting the digital equivalent of the ISO setting to 
a faster speed can introduce noise to the photo. Similar to the graininess from 
high-ISO film, noise is random pixels in the photo that are slightly off-color or 
too bright. Cameras vary widely, so it is worthwhile to experiment with your 
digital camera’s ISO settings and examine the results. 

In low-light situations, consider turning off the flash and setting the camera to 
a faster ISO setting. This may produce some noise in the photo. But that result 
might be preferable to what you’d get by taking the photo at slower ISO setting 
with the harsh lighting of the on-camera flash.

ASA versus ISO
If you have an older 
camera, the film speed 
dial might be labeled 
ASA instead of ISO. 
These film speed 
ratings are the same, 
and the ratings are 
interchangeable.

Avoid sharpening a 
photo with noise
Do not use the 
sharpen feature in 
Picture It! on digital 
photos with noticeable 
noise; sharpening 
accentuates the 
inaccurate pixels.
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Setting the White Balance
Most digital cameras are automatically programmed to calculate the proper 
white balance for each exposure. To calculate the white balance, the camera 
assumes the lightest spot in the picture is white, and adjusts the other colors 
accordingly. Under most circumstances, this automatic function should prevent 
an off-color cast in your photos. 

However, in some lighting conditions, the camera fails to correctly set the white 
balance. If you’re shooting indoors, for example, incandescent lights give off 
a yellowish or reddish glow. This color is not really visible to the naked eye, 
but often shows up in indoor photos. To counteract this problem, most digital 
cameras have preprogrammed color balance settings that compensate for 
different kinds of light. Typical settings include cloudy, shade, incandescent, 
flash, fluorescent, and sunny. These settings compensate for the different colors 
of light likely to be present in those conditions, and should produce photos that 
require little or no color correction. Read your camera’s manual to find out 
about specific white balance settings it offers.

With film cameras, there is no way the camera itself can compensate for dif-
ferent lighting conditions. But there are two ways you can compensate for the 
colored light: 

 Use film designed for specific lighting situations. Tungsten-balanced 
films, for example, help to neutralize the color of tungsten or halogen 
illumination.

 Use a filter on your camera lens. For example, if you’re using daylight-
balanced film but want to shoot indoors, you can use a blue-colored filter 
to absorb the overriding yellows and reds of the indoor incandescent 
lights. 

Correcting tint in 
Picture It!
If your photo has a 
colored cast from a 
light source, correct 
the problem with the 
Picture It! Adjust Tint 
tool. 

Setting the white 
balance manually
Some digital cameras 
offer manual white 
balance control. This 
feature allows you to 
set the white balance 
by focusing on a pure 
white object, such as 
a piece of paper, and 
then locking down the 
white balance before 
you take the photo. 
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Using Automatic Modes on Your Camera 
Many of the automatic cameras sold today—even some of the less-expensive 
models—have preprogrammed modes that are designed for special situations. 
Sometimes called program modes, these modes automatically adjust your cam-
era to special settings designed specifically for things like macro photography, 
action shots, portraits, panoramic mode, or picture series. 

If you’re a beginning photographer who is not always confident enough to 
adjust your camera’s manual settings, use the automatic modes to help you take 
better photos. 

If your camera does not allow you to adjust settings manually, the automatic 
modes may be the most likely way for you to take successful photos in these 
situations. 

The following sections describe the most common automatic modes available 
on many digital and film cameras. Since the type and implementation of auto-
matic modes vary for each camera, read your camera’s manual for availability 
and usage instructions.
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Macro Mode
Most cameras in automatic mode have trouble focusing on objects that are 
less than 12 inches (30 centimeters) away. So when you’re shooting close-up 
photography, like capturing a special piece from your coin collection, you need 
to set your camera to macro mode. Macro mode adjusts the focal length to 
accommodate the unusually short distance to the subject.

Macro mode usually reduces aperture, which widens the depth of field, and 
increases the chances that the whole subject is in focus. 

The camera’s macro mode was used to capture the fine detail of the jewelry.

When using macro mode, make sure to turn off the flash, since the flash does 
not provide proper illumination at such close range. Tripods are a good way to 
keep the camera steady for a close-up shot. If you don’t have a tripod, set the 
camera on a firm surface, focus the photo, and then activate the shutter with 
the self-timer. This way, your hand does not have to touch the camera and 
accidentally introduce any movement to the shot.
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Action Mode 
If you’re photographing subjects such as athletes, moving cars, or even fast-
moving children, a camera’s action mode helps keep your subject in focus. 
The most significant characteristic of action mode is the faster shutter speed 
of at least 1/500th of a second, which helps to freeze the action of your moving 
subject. The action mode in most cameras also uses a wider aperture setting (to 
offset the fast shutter speed), and multipattern light metering, which compen-
sates for overly bright and overly dark areas.   

Action mode uses a fast shutter speed to freeze the action of a fast-moving subject.

Digital cameras create a unique challenge for shooting action photography: the 
time lag between when you press the shutter button and the actual exposure. 
With film cameras, pressing the shutter button causes the shutter to open virtu-
ally simultaneously. But with digital cameras, you might have to wait as long 
as four seconds before the photo is taken. When shooting moving objects, four 
seconds can seem like an eternity. 

One way to compensate for the shutter lag is to anticipate your shot. Imagine 
you are photographing a runner with a camera that has a four-second shutter 
lag. (The four-second shutter lag will not be highlighted on the camera’s 
packaging, but you can figure it out through your own experience.) First, focus 
your camera on a spot that the runner will cross in about 10 seconds. When 
the runner is only four seconds away from your target spot, press the shutter 
button. The exposure should occur just as the runner comes into your field of 
focus. 

Another way to shoot a moving subject is to pan your camera with the action. 
While a stop-action photo freezes everything in the photo, panning your 
camera keeps your moving subject in focus, but blurs the background. For this 
effect, you do not want to use the action mode, because you do not want a fast 
shutter speed. To accomplish this effect, follow your moving subject in the 

When the lag is a 
drag
Some digital cameras 
have a much shorter 
shutter lag than 
others. You may want 
to consider this factor 
when buying your next 
camera.
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viewfinder (or LCD screen) as it moves, but pan the camera so that your subject 
remains in the same position in the frame. Your result won’t show the subject in 
as clear a focus as stop action, but the blurred background helps to pronounce 
the speed and movement of your subject.

Since the camera panned with the subject, the girl is in fairly sharp focus and the background 
is blurred. This helps convey movement.
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Burst Mode
Burst mode is a feature that allows you to take a series of photos in quick suc-
cession. Most cameras’ burst modes allow you to take 10 to 15 photos in 5 to 15 
seconds.

Even on digital cameras with slow shutter lags, the burst mode still allows you 
to take many frames in a short time span. The burst feature uses a buffer to 
temporarily hold the information from the image sensor. After the set of 10 to 
15 frames is stored in the buffer, the camera processes each frame separately 
and sends them to the removable storage media.

If your camera has a burst mode feature, you can use it to overcome the slow-
ness of the shutter lag. When photographing a child, for example, it can be hard 
to get the child to pay attention for the few seconds that it takes to shoot the 
photo. But with burst mode, you might be able to shoot 10 frames within 10 
seconds. During that 10 seconds, you can encourage the child to talk, look at 
the camera, and make different movements and expressions. It’s doubtful that 
all 10 exposures will turn out to be great photos, but you’re much more likely to 
get at least one good shot than if you’d just taken a single frame.

Another great use of the burst mode feature is to take a photo series of an action 
sequence. Create a series of photos of a golf swing, a child riding a bike, or a 
pet moving across the yard. Then you can assemble the whole series in a slide 
show, or mount the photos together in a frame. 

Showing the whole 
series online
Picture It! offers 
Flipbook animations 
as a creative way to 
present a series of 
photos in sequence.
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Portrait Mode
For portraits and candid shots, using your camera’s portrait mode is a 
convenient way to get good results. Portrait mode is set to use a relatively wide 
aperture, creating a shallow depth of field. With only your subject in focus, 
objects in the background are less distracting, and your subject dominates the 
frame. 

With a shallow depth of field, it’s crucial that you get your subject in sharp 
focus. If your depth of field is so short that you can’t focus on every part of your 
subject at the same time, focus on the subject’s eyes, and let hands and feet be 
less in focus. 

For this portrait, the Diffuse Glow filter was applied in Picture It! to soften the focus.

For successful portraits, remember to fill the frame, and use a slightly telephoto 
lens, such as a 105mm, or a slight zoom setting. Keep the background very 
simple, unless you are using objects in the background as context for your sub-
ject. If shooting indoors, an off-camera flash or other light source works best. 

Reduces wrinkles 
and blemishes!
The Diffuse Glow filter 
available in Picture 
It! works well when 
applied to portrait 
photographs. The filter 
simulates the effect of 
using a soft diffusion 
filter on your camera, 
softening the photo and 
minimizing wrinkles or 
blemishes.

Relaxing your 
subject
An important 
aspect of portrait 
photography is to get 
your subject relaxed 
and comfortable for 
the pose. Try using 
conversation or other 
pleasant distractions to 
get your subject’s mind 
away from the camera.
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Panoramic Mode
For landscapes, large groups of people, and other long horizontal shots, a 
camera’s panoramic mode helps you compose the photo without too much 
sky or ground in the photo. Panoramic shots have a different aspect ratio than 
standard shots, meaning the width of the frame is proportionally much greater 
than in a photo with a standard aspect ratio. 

Some panoramic cameras take photos with an aspect ratio of 4:11 (four units 
tall by 11 units wide), compared to the aspect ratio of 3:4 for standard shots 
on most digital cameras. As with the shape of a movie theater screen versus a 
television screen, the wider frame gives you some new creative territory when 
composing your photo. 

Switching your camera to panoramic mode gives you new compositional possibilities.

True panoramic cameras use a wide-angle lens to let you capture more width 
of the scene by staying in the same position. Many cameras, including digital 
cameras and APS cameras, offer a panoramic mode without a wide-angle lens. 
Instead, the panoramic effect is achieved by simply cropping off the top and 
bottom of the frame. This type of panoramic shot does give you a wider aspect 
ratio, but not a wider angle. On some digital cameras, using the panoramic 
mode means that each photo has fewer pixels (since the top and bottom are 
cropped), so each panoramic shot takes up less space on your storage media.  
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Using the Self-Timer
Many digital cameras, even inexpensive ones, come with a self-timer feature. 
Some self-timers open the shutter after a preset amount of time, such as 10 
seconds; others allow you to adjust the length of time before the shutter fires. 
Either way, this fairly simple feature is great for getting yourself into a photo 
and for taking long exposure shots.

Getting Yourself into a Photo
To get yourself into a photo, plan where you want to position yourself for the 
shot. Then set up the camera by putting it on a tripod, a table, or any other flat, 
stable surface. With your camera in position, focus the camera on your subject, 
which should be close to the position where you will stand for the photo. 

If your camera has autofocus, press the shutter halfway down to focus, press the 
self-timer button, and then press the shutter all the way down. Then you’ve got 
about 10 seconds to get yourself in position for the shot. 

Taking Long Exposure Shots
Another great use of the self-timer is for exposures with a relatively slow shut-
ter speed. For speeds slower than 1/30th of a second, there is a good chance the 
slight movements in your hands will cause blurriness in your photo. Even if you 
have very steady hands, the slight movement of your finger pressing the shutter 
button can create movement. Using the self-timer will eliminate this problem. 
By setting the camera on a firm surface and using the timer, your hands don’t 
have to be anywhere near the camera while the shutter is open.

Creating a 
makeshift tripod
If you’re outdoors, try  
propping the camera 
on a rock or car roof. 
Then fine-tune the 
positioning by putting 
the camera on a jacket 
or other object that you 
can shape to adjust the 
camera angle.
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Ten Tips for Great Pictures
The following 10 tips offer suggestions for developing your photography 
approach, technique, composition, and habits. If you are an inexperienced 
photographer, some of these tips might be new ideas for you. If you’re a photog-
raphy veteran, these tips might be a good reminder of things you haven’t heard 
in a while. Either way, we hope they inspire you to get out and shoot some great 
photos!

1. Know Your Gear
Having command of your equipment is an important aspect of enjoying and 
being successful with photography. As you get to know your gear and gain 
confidence in a camera’s capabilities, the camera can become an extension of 
yourself. When you have reached this level of competence, you can concentrate 
more on the creative aspects of photography. 

When you get a new camera, first read through the manual. With digital cam-
eras especially, operating the controls may not be intuitive, since many digital 
cameras’ controls must be accessed through menus on the LCD screen.  

After you’ve read the manual, and you understand how and when to use your 
camera’s features, go out and take a variety of photos using the different 
settings. Take some photos outdoors and indoors, with the flash and without 
the flash, with automatic settings and with manual settings. As you shoot, 
take notes to record the settings used for each shot. Later, look at your photos 
on your computer, and take note of both the settings that worked well and the 
settings that produced poor results. 

Missing a great photo because you get hung up on technical issues is frustrat-
ing. Spend time getting to know your gear, and prepare for great photo 
opportunities.  
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2. Nail the Exposure
In a finished photo, exposure is something that you usually only notice when 
it is out of adjustment. A perfect exposure is not something that jumps out 
at you from a photo, but a problem exposure definitely stands out. In an 
overexposed photo (caused by too much light), the shadow areas are light, and 
the highlighted areas are almost entirely white. In an underexposed photo, too 
little light has been let into the camera, creating a photo that lacks detail, with 
filled-in shadow areas and dull highlighted areas.

Special lighting situations can fool the built-in light meter in your camera. If 
you want to start with the camera’s automatic exposure, use exposure compen-
sation to fine-tune the exposure. The following list describes some common 
lighting problems and the recommended exposure compensation for each: 

 For a side-lit subject: Increase exposure by one-half of a stop.
 For a backlit subject: Increase the exposure by one stop. Or step in close 

and meter directly on the subject, step back and recompose, and then 
shoot at the reading you took on the subject. You can also switch to spot 
metering.

 For a small dark subject against a bright background, or any subject in 
a very bright scene: Use exposure compensation of +1 to +3, or increase 
exposure by one to two stops, for example, from f/8 to f/5.6 or f/4.5.

 For a small, light subject against a dark background: Use exposure 
compensation of -1, or decrease exposure by one stop, for example, from 
f/8 to f/11.

Planning for the 
imperfect
Learning to nail the 
exposure takes a lot 
of experience, and 
no one gets it right 
with every shot. If you 
suspect the lighting 
might make it difficult 
to nail the exposure, 
you can increase your 
chances of success 
by bracketing, as 
explained in tip #7.



102 Chapter 12: Taking Great Pictures

Microsoft Picture It! Photo Premium User’s Manual

103Chapter 12: Taking Great Pictures

Microsoft Picture It! Photo Premium User’s Manual

3. Capture a Moment in the Story
Consider driver’s license and passport photos. We think of these photos as 
uninteresting and unrepresentative of how people usually look. Why are these 
photos dull?

One problem with these photos (but certainly not the only problem) is that 
they capture people out of their element, without context or a story. There are 
no interesting details in the background to draw in the viewer, and the subject 
often looks impatient or uncomfortable.

When you are the photographer, you can strive to capture people, events, and 
places that tell a story. In addition to having your subject look natural and not 
posed, details in front of the subject or in the background can stimulate the 
imagination to re-create the story of the photo. 

This photo captures the destruction of an earthquake just hours after the event. Since the 
photo was taken before the rubble was cleared away, the photographer was able to capture 
the many details of the scene that tell the story.

With enough of these details, and a strong relationship between your subject 
and the other elements, the photo can suggest ideas that are not even in the 
frame. You can take the old cliché “A picture is worth a thousand words,” and 
make it your goal to paint more than a thousand words with your photographs.
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4. Look for the Light
Many of the best photographs are taken early in the morning, late in the after-
noon, and at twilight. At these times the lighting is most dramatic.

Many photographs are shot in bright or moderately bright sunlight. This type 
of light produces photos that closely match the way we remember seeing the 
scene. That is part of the reason we respond to them with a positive sense of 
familiarity.

However, colors photographed in the cooler light at twilight or in overcast 
conditions, or in the warmer light of sunrise and sunset, offer a new perspective 
on familiar colors and subjects, and provide a more creative backdrop for pho-
tographs. Overcast and after-the-rain conditions, in particular, produce richer, 
more saturated colors. For example, red leaves photographed against a twilight 
backdrop, instead of in daylight, create a moody interpretation that suggests a 
sense of mystery or drama.

In the dim light of a rainy day, the red leaves in this photo look especially vivid.

For interior photographs, look for strong sources of natural light, as from a win-
dow or a skylight. The glow of light coming from one direction can illuminate 
your subject dramatically. 
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5. Follow the Rule of Thirds
When composing a photograph, many beginning photographers always center 
their subject directly in the middle of the frame. While this technique may be 
the easiest way to get the subject in focus with a point-and-shoot camera, it is 
not always the most interesting way to present the subject. 

Most advanced photographers follow the rule of thirds when composing the 
space inside a picture frame. The rule of thirds divides the frame into thirds 
both horizontally and vertically, and places the point of interest on one of 
the four spots where these dividing lines intersect. The rule of thirds is used 
throughout the graphic design world, because it helps to create balance between 
the subject and the background.

To apply the rule of thirds, divide your scene into three sections horizontally and vertically. 
Place the focal point of your photo on one of the intersections of the dividing lines.

Following the rule of thirds, the bicycle in this photo lies right on the of the points where the 
dividing lines intersect. The top of the dock also roughly follows the horizontal line that runs 
one-third down from the top of the frame.

If you have a person or animal in your photo, you can place the subject’s face 
on one of the four points, looking toward the center of the scene. If the horizon 
is in a photo, it should run about one-third from the top or one-third from the 
bottom, depending on whether the terrain or the sky is the center of focus.

The rule of thirds is not an absolute law, and there have been many great 
photographs taken that don’t abide by it. But the rule can be a great way to add 
balance and interest to your photos.

Recomposing 
a photo with 
Picture It!
After a photo has 
been transferred 
to your computer, 
use the crop tool in 
Picture It! to change 
the composition. By 
clipping away the edges 
of the photo, you can 
reposition your subject 
to comply with the rule 
of thirds. 
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6. Find a Unique Perspective
You can challenge yourself to take original photos that convey unique perspec-
tives. Rather than just pressing your shutter button as soon as you have the urge 
to capture a scene, take some time to assess your shooting angle, proximity to 
your subject, and background elements. You may transform your composition 
by taking one or more of the following simple steps:

 Get closer to your subject, to show more detail and eliminate distractions 
in the background.

 Include just a portion of your subject in the frame.
 Take your original subject and place it in the background. Find a new 

subject that adds context to the object in the background.
 Get lower to the ground, and point the camera up toward your subject.
 Move to a higher location, above your subject, so you are pointing down 

when you take the photo.

For example, if you are traveling, your natural instinct might be to take 
straightforward photos of local monuments. But with this approach, you might 
wind up with the same lackluster photos taken by scores of other tourists before 
you. And there would be a good chance that a nearby souvenir shop would sell 
superior, professionally photographed prints and slides of the same monuments. 
For that matter, you could have just stayed home and ordered the professional 
photos from a catalog.

Use your imagination to compose some original, creative photos that you won’t 
find anywhere else. Capture some of the local color by photographing a lively 
food vendor stationed near the monument, and the monument can be the back-
drop in your frame. Or use the self-timer to capture you and your companion 
sampling the local fare that you’ve bought from the food vendor in front of the 
monument.   
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7. Bracket
The term bracket means to create exposures that are both lighter and darker 
than the camera or light meter indicates. The idea is to second guess the purely 
mechanical exposure meter, so that you get the right exposure. 

If you’re taking photos of a sunset, a scenic vista, or a plant, you have the time 
to bracket. With these subjects, you’re also likely to have a wider range of tones 
to record than your camera can handle, especially if your subject is brightly lit. 

So how do you bracket with an automatic camera? Most digital cameras, and 
many automatic cameras, have an exposure compensation feature, sometimes 
called the EV setting. If you set the exposure compensation for -1, the shot is 
one stop underexposed (darker than normal). If you set the camera for +1, the 
shot is one stop overexposed (lighter than normal). So you can bracket by tak-
ing three photos, one each at the -1, 0, and +1 settings.

Some cameras offer an automatic feature, which takes a range of photos, each 
with a different exposure setting.

Even if your camera doesn’t permit you that much control (or if you don’t want 
to take the time to change the exposure settings), another technique will give 
you results similar to bracketing. To get a lighter exposure, aim your camera at 
a darker portion of the subject, and then press the shutter button partway down 
(until you begin to feel a little resistance). Next, without releasing pressure on 
the shutter button, reframe your photo to include what you want, and then push 
the shutter button all the way down to take the photo. 

Depending on your camera, pressing the shutter button halfway down may lock 
in the exposure and the focus. If this is the case, you need to set the exposure on 
an object that is exactly the same distance away from the camera as the subject. 
Otherwise, your subject will not be in focus when you take the photo.
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8. Analyze and Shoot Again
Photography takes practice. And you will progress at a faster rate if some of 
your practice time is focused on developing specific skills. One way to do that 
is to analyze your photos, and then go shoot them again.

When you get a chance to look at your photos on a computer or as prints, you 
can assess their quality of composition, lighting, exposure, and white balance. 
Upon close inspection, you might realize that you placed your subject too close 
to the center of the frame, or that incandescent lights caused an orange glow. 
On your next shoot, go out and take this same photo again, and make adjust-
ments for the problems you encountered before. 

When you look at the results of your second round of photos, you may find that 
you got excellent results, or you may find that one of your adjustments disrupted 
something else in the photo. Or maybe the different lighting conditions of the 
different day made it more difficult to nail the exposure.

To continue the exercise, shoot the same subject or scene on a regular basis. 
You must always compensate for the differences in lighting each day, but you 
can try new approaches to the composition. Learning to shoot the same subject 
under different conditions or with a different approach gives you valuable 
experience and ideas when you encounter new situations.

A quick check with 
the LCD
One of the benefits of 
digital photography is 
that you can get a look 
at your photos on the 
LCD preview screen 
right after you’ve taken 
the shot. This feature 
is great for a quick 
analysis of the photo’s 
composition, exposure, 
and color tone. Just be 
aware that since the 
preview screen is so 
small, it often does not 
reveal problems with 
focus.
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9. Shoot Every Single Day
To become a talented and confident photographer, make photography part of 
your daily routine. Fortunately, digital cameras have made it much more conve-
nient and inexpensive to shoot lots and lots of photos. Once you’ve purchased 
your digital camera, you can take as many photos as you want. The only cost is 
for batteries and storage for your photos.

The more you practice, the more confident you’ll become in your skills and in 
your equipment. You’ll also develop the habit of keeping your camera close by, 
and having it ready for photo opportunities. Train yourself to look for these 
opportunities, and take advantage of them when they come to you. Some of 
the world’s most memorable photos were taken by amateur photographers 
who happened to be in the right place at the right time. So to be ready to take 
that once-in-a-lifetime shot, know how to use your gear, have your equipment 
handy, and be on the lookout for great photo material. 
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10. Show Your Photos to Other People 
Even when you are making great progress with your photography skills, it’s 
easy to overlook the shortcomings in your own work. To continue improving 
your abilities, show your photos to other people. Getting others’ opinions is an 
invaluable learning experience. 

Good photos should be visually exciting to people, eliciting a “Wow, this is 
great!” response. If you find that people are not very excited by your photos, ask 
them what they think is missing, and what you could do to make them better. 
You’ll be surprised what some people like and do not like about your photos.

Find other photographers in your community. You can look at each others’ work 
and give feedback. This kind of mutually beneficial arrangement also helps you 
to develop your critical eye.

While it’s important to show your photos to others, remember that you are the 
ultimate judge of your own work. Photography is an art, and as an artist you 
should establish your own voice and style. You don’t have to listen to every 
piece of advice, and you may produce your best work by taking chances and 
following your own instincts.

That said, photographs are made to be seen! As you improve your photography 
skills, showing off your photos can be the best part.
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